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1. Introduction

BIAevaluation is a stand-alone software package for presentation and
evaluation of sensorgram data from real-time BIA analyses. The
software supports

• evaluation of kinetic constants from sensorgram data using
numerical integration and global fitting methods

• pre-defined and user-defined interaction models

• simulation of sensorgrams from specified models and kinetic
parameters

• determination of affinity constants for both surface and solution
interactions

• analysis of concentration measurements from either binding level or
rate data.

BIAevaluation version 3.0 differs in several significant respects from
the previous versions 2.x, both in terms of the functionality of the
program and the user interface.

1.1.1 New functionality
The approach used for fitting experimental data to an interaction
model has been revised and improved, with the result that the software
is both easier to use and more powerful. Major new features include

• Simultaneous fitting to all curves in the working set, which improves
the robustness of the fitting procedure. When one or more variables
are in addition constrained to have the same value for each curve
(e.g. association or dissociation rate constants), this is referred to as
global fitting. Global fitting contributes greatly to the stability of the
fitting procedure for complex models with many variables, and also
reflects many physical interaction systems more faithfully (a set of
sensorgrams for the same interaction at different analyte
concentrations should a priori have identical rate constants).

• Simultaneous fitting to association and dissociation phases of the
interaction, which improves the data throughput in the evaluation
process. Separate fitting of the association and dissociation phases is
also supported.

1.1 Differences from version 2
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• The use of numerical integration algorithms allows evaluation
according to complex interaction models, where analytical
integration of the rate equations is difficult or impossible. This
removes a serious limitation in previous versions of BIAevaluation,
which were unable to handle non-integratable rate equations.

• A model editor based on reaction schemes instead of rate equations
makes it easier to defined interaction models. The rate equations for
the model as defined are displayed as an aid in checking the
correctness of the model.

• Combined kinetic and concentration evaluation modules with
integrated spreadsheet functions make it easier to perform
concentration measurements using sensorgram data (binding rates or
steady state levels). Report point tables can be opened directly in the
spreadsheet from BIA result files for direct concentration evaluation.

• An improved 4-parameter fitting equation is introduced for more
reliable creation of standard curves for concentration measurement.

1.1.2 New interface features
BIAevaluation version 3.0 is fully compatible with the Microsoft®

Windows®  95 and Windows NT (version 4.0 or later) graphical user
interfaces. New interface features introduced since version 2.x include:

• Long file names are fully supported.

• Tool tips provide assistance in using the toolbar buttons and in
understanding dialogue boxes and data presentation. To display a
tool tip, place the mouse cursor on the item for which you want help
and wait a few seconds. The tip appears automatically (see
illustration below).

Tool tip for the parameter Conc  in kinetic data evaluation.
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• Software wizards guide you through procedures such as fitting
kinetic data, opening text files and simulating sensorgrams. Wizards
are sequences of dialogue boxes, often with text instructions, where
Next  and Back  buttons allow you to step through the procedure and
to return to previous steps without restarting the whole procedure.
See Section 4.1.2 for a full description of a wizard example.

Example of a wizard dialogue box (from kinetic evaluation).

• Right mouse button menus or context menus are implemented in all
graphical display windows. These are pop-up menus that appear
when you press the right mouse button (left mouse button if you are
using a left-handed mouse setting). The menu for plot windows
offers commands for copying the plot window to the clipboard,
exporting the data from the plot window, and setting presentation
properties for the window. The right mouse button menu can be
used at any time, even when the main menu commands are not
available (e.g. when a wizard dialogue box is displayed).

• 

The BIAevaluation workspace can display the following windows:

• One (and only one) project window. The project window contains a
list of  the curves currently available for presentation and evaluation.
Curves may be imported into the project window from several
different source files including BIA result files and text files, or may
be derived by transformation of source curves within BIAevaluation.

1.2 The BIAevaluation workspace
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A project window with original and transformed curves.

• Any number of plot windows. A plot window is a display of one or
more curves from the project window. The curves included in any
given plot window are collectively termed the working set for the
window. The same curve can be displayed simultaneously in several
plot windows: however, changes made to a curve in one plot
window (by data transformation or changes in display properties)
will affect the curve in all windows.

A plot window.

• Any number of fit windows. A fit window is obtained from a plot
window by fitting the curves in the plot window to a model
equation. The fit window replaces the plot window, and display the
results of the fitting both graphically and numerically. One fit
window can contain any number of fits to the same curves.



______________________________________________________________________ Introduction

BIAevaluation Software Handbook 1-5

A fit window.

• Any number of sheet windows. A sheet window displays data
numerically in a spreadsheet, which supports generation of
calibration curves for concentration measurement as well as several
common spreadsheet operations (filters, arithmetical operations and
graphing functions).

A sheet window.
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• Any number of calibration windows. A calibration window displays
a calibration curve generated from spreadsheet data for
concentration measurement, and is used for calculating
concentrations in unknown samples.

A calibration window.

BIAevaluation projects are saved to disk in project files (filename
*.ble). Saving a project file saves the current state of the workspace
including all open windows. Saving transformed curves in a project file
does not affect the original curves in the source file.
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2. Installation

Recommended system requirements for BIAevaluation are

Processor Pentium 166 MHz or faster

RAM At least 16 Mb

Windows version Windows 95 or Windows NT version 4.0

Printer Colour printer

Close all running programs before installing BIAevaluation.

The software is delivered on five diskettes. To install the software:

1. Insert diskette 1 in the floppy disk drive.

2. Choose Add/Remove Programs  in the Windows Control Panel. In
the program installation wizard, choose to install software from
diskettes. The installation program is a:\setup.exe .

3. Click on Finish  and follow the instructions on the screen. The
default installation folder is C:\Program Files\Biaeval . You will be
required to enter your site name and software serial number
during the installation procedure. The serial number is printed on
the label on diskette 2.

2.1 System requirements

2.2 Installation procedure
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Additional information on BIAevaluation Software may be found in
the Read.me  file. A shortcut for opening this file in Wordpad is placed
under BIA Programs  in the Windows start menu.

Notes: If you are installing BIAevaluation 3.0 over a previous version,
models from the previous version will be saved in a file called
Bia_old.mdl . If you want to use models from your previous
installation (e.g. custom-written models), start BIAevaluation
and use File:Import models  to import chosen models from the
Bia_old.mdl  file. See Section 7A.2.7 for details of importing
models.

If BIACORE X Control Software version 2.0.x is installed
with BIAevaluation 3.0 present on the computer,
BIAevaluation 3.0 must be reinstalled in order to work
correctly.

Example data in text files provided with BIAevaluation uses a
stop (.) as a decimal separator. If your Windows settings use a
different separator, you may either change the setting
temporarily in order to open example text files, or use the
search-and-replace function in a word processor or text editor
to change the decimal separator in the text files. Remember to
save the files as text files if you use a word processor to make
the changes.
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3. Data presentation

For information on how to start BIAevaluation, see Section 7.1.

To load data from source files into the project window, choose
File:Open  or press the Open  button on the toolbar.

You can open the following types of files in BIAevaluation:

• previously saved BIAevaluation projects, including BIAevaluation
version 2.x (extension .ble)

• result files from BIACORE instruments and from BIAlite (extensions
.blr, .blc, .bls, .blf)

• report point tables from BIACORE (extension .rpt) or concentration
evaluation files from BIAevaluation version 2

• text files containing tab-separated data (default extension .txt)

One project can include curves derived from several source files of the
same or different types. The curve data used in the evaluation project
is a copy of the data in the source file, and changes made to the curve
in BIAevaluation do not affect the contents of the source file.

3.1 Opening data files
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3.1.1 Previously saved projects
If the current project is empty when you open a previously saved
project (extension .ble), the project is opened in the state in which it
was saved, including any plot windows and fitting windows that were
open at the time the project was saved.

If the current project is not empty when you open a previously saved
project (extension .ble), you may choose to replace the current project
or to add the curves to the current project:

If you choose to add curves to the current project, select the curves to
add from the dialogue box:

Note: If you choose to add curves from the saved project to the
current project, only the curves are loaded into the project
window for the current project. Any plot windows and fitting
windows in the saved project are not opened.
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3.1.2 BIACORE and BIAlite files
Data can be loaded from result files from BIACORE instruments
(extension .blr, blc and bls) and BIAlite (extension .blf) as curves
(sensorgrams), report point tables or both. To simplify selection of
curves, you can choose to display only curves with a specified value
for a chosen report point keyword. Some options in the dialogue box
may not be available for older result files.

The dialogue box displays file description information where
available, including date, control software version and instrument ID.

Curves from BIACORE and BIAlite result files are always added to the
current project window. Report point tables are opened in a
spreadsheet window (see Section 3.5).

Curves Only Sensorgrams will be added to the current project
window. The report point table is ignored.

RPoint Table
Only

The report point table will be opened in a
spreadsheet. Sensorgram data is ignored.

Curves and
RPoint Table

Sensorgrams will be added to the current project
window and the report point table will be opened in
a spreadsheet.

Curve list Select the curves to be opened. Shift-click to select
multiple adjacent curves: Ctrl-click to select multiple
non-adjacent curves.

Keyword/Value The curve list shows only curves that fit the selection
criteria in the Keyword  and Value  fields. The
keywords and their possible values are taken from
the report point table in the result file. (Note
however that selection of keyword and value does
not affect report point data that will be loaded into
the spreadsheet.) You can use this selection to restrict
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the number of curves listed and make selection
easier. For example, to list only curves from flow cell
1, choose Fc in Keyword  and 1 in Value .

Use Original
Colours

Check this box to keep the original curve colours
from the result file. If this box is not checked,
BIAevaluation will assign colours to the curves.

3.1.3 Text files
BIAevaluation can load data from text files containing tab-separated
columns of data values, either as curves or as a spreadsheet. For
curves, the first entry in each column is read as the name of the data
set in the column. Curves can be created from any combination of
pairs of data sets.

Opening a text file first presents a preview of the file contents in
spreadsheet format:

To open the file as a spreadsheet, select Sheet  under Open As  and
click Finish .

To open the file as curves, select Curves  under Open As  and click
Next> . In the next dialogue box, select the data sets you want to use
for x- and y-values and then click Finish .
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By default, curves are suggested from pairs of data sets with the same
name and with suffixes x and y if such labels exist in the text file:

Curve X-axis Y-axis
1 Data set 1_x Data set 1_y
2 Data set 2_x Data set 2_y
3 Data set 3_x Data set 3_y
... ... ...

To add a curve which is not in the default list, click on the required
data sets in the X-Values  and Y-Values  lists, then press Add=> .

You can also choose to form a curve from generated x-values together
with a chosen data set for y-values. To do this, choose Generate  under
X-Values  and enter the starting value and step value in the dialogue
box that follows. Choose the required data set under Y-Values  and
press Add=> . The curve will be generated by incrementing the x-value
with the specified step for each value in the chosen data set.

Notes: When you open a text file, you have full freedom to choose
any pair of data sets to create a curve. Choosing the correct
data sets is easier if the first item in each column in the text
file is an intelligible identification of the data in the column.
Text files created from BIA software automatically have a
column identifier at the top of each column.

Exported report point tables (extension .rpt) are opened as
text files.
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The examples that follow are taken from the BIACORE result file
kinetics.blr , included with BIAevaluation software. Open the file and
load all the curves into the project window.

3.2.1 Displaying curves
The project contains five curves as displayed in the project window.
Curves to be displayed in a plot window are selected from the list in
the project window. To select one curve, click on the curve name. To
select several adjacent curves, drag the cursor through the group while
holding down the left mouse button, or hold down the Shift key while
you select the first and last curves in the group. To select several non-
adjacent curves, hold down the Ctrl key while you select each curve.
The curves you select define the working set for the plot window. In
the example, select curves 1-5 in the project window.

Press the Overlay plot  button or choose View:Overlay plot . This opens
a plot window with the selected curves in an overlay plot.

3.2 Presenting the data
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The sensorgrams in kinetics.blr  show association and dissociation
phases followed by a regeneration pulse.

With a plot window active, the Overlay plot  button toggles between
overlay and single plot mode. In single plot mode, only one curve is
displayed at a time: you can choose the curve to display from the
Curve  list in the toolbar. Note that the display mode does not affect
the number of curves in the working set. You can check which curves
are in the current working set by expanding the Curve  list in the
toolbar.

3.2.2 Changing curve properties
For presentation purposes, the appearance of curves can be set with
the Edit:Curve Properties  command. This command is available when
either a project or plot window is active. Choose the command to
change the properties of the active curve or double-click on the curve
you wish to change.
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3.2.3 Scaling the display
You can scale the display either by setting scale values or by zooming.

To set scale values, choose View:Scale  from the main menu or Scale
from the right button menu, or double-click on an axis in the display.

If Auto  is checked for either x- or y-scale, the display will be scaled to
show the whole curve(s) in the respective direction. To define a display
area, uncheck Auto  and enter values for the minimum and maximum
values on the scale(s). To return to display of the whole curve(s), either
choose View:Scale  and check Auto  in the dialogue box, or choose
View:Adjust Scale .

To scale by zooming, drag with the left mouse button over the area to
be displayed. To return to the previous zoom level, either choose
View:Unzoom  or double-click anywhere in the display area except on a
curve or axis.

3.2.4 Displaying gridlines
You can display gridlines for x- and y-axes in plot and fitting windows
with the View:Gridlines  command from the main menu or Gridlines
from the right button menu,. Major gridlines are drawn on numbered
tick-marks on the axis, and minor gridlines on unnumbered tick-
marks. Tick-marks are set automatically by BIAevaluation.
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3.2.5 Labels and legends
You can add a title to the plot and change the labels on the x- and y-
axes with the View:Labels  command from the main menu or Labels
from the right button menu,. The default labels are imported from the
curve, and for sensorgrams are Response  for the y-axis and Time  for
the x-axis.
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You can display a legend in a plot window with the View:Legend
command from the main menu or Legend  from the right button
menu,. The legend shows the line type and colour and curve name as it
appears in the project window for each curve in the plot, and can be
placed at the top, bottom or sides of the window.

Plot window with legend and title.
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There is a range of curve transformations that can be performed in
BIAevaluation in both x- and y-directions. A full description of
transformation facilities may be found in Sections 7B.5.1 and 7B.5.2.
The sections below illustrate four examples: removing unwanted parts
of the sensorgram, adjusting the curve baseline, aligning injection
points and normalizing curves. Removing unwanted data and
adjusting the baseline are normally the first steps in kinetic evaluation
(see Section 4.1.2). Aligning injection points is helpful for files where
one sensorgram includes several injection cycles (BIAlite and
BIACORE X), and also for multi-channel injections (BIACORE X and
BIACORE 2000) where there might be a slight displacement between
curves.

3.3.1 Removing unwanted data
The example sensorgrams in kinetics.blr  include a regeneration pulse
where the response falls well below the pre-injection baseline. For
presentation and/or analysis purposes, you may wish to delete this part
of the sensorgrams so that only the interaction phases remain.

1. Select the section of the curves to be cut. Drag the cursor with the
right mouse button to select the curve section. In the example,
select data from just before the regeneration pulse to the end of
the sensorgram. Alternatively, you can choose Edit:Select and
enter the start and end times for the section to be selected.

Once a section of data has been selected, you can drag the
handles on the selection area using the left mouse button to adjust
the selection limits. Make sure that the upper limit of the
selection area extends beyond the end of the sensorgram.

3.3 Data transformation
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2. Choose Edit:Cut  (keyboard shortcut Ctrl-X). The selected data
will be deleted from all curves displayed in the plot window. The
display will be rescaled automatically. (If the display is not
rescaled, you have probably not selected data all the way up to
the end of the sensorgram. This removes a section of data from
within each curve, leaving a set of discontinuous curves.)

Notes: In single plot mode, data will only be deleted from the
currently displayed curve. Other curves in the working set will
not be affected. You can delete data from a single curve in
overlay mode by using Edit:Select  to select the data and
unchecking Apply to all curves in working set .

The data is deleted from the curves in the project window,
and any new plot windows which use the same curves will
display the data without the regeneration pulses. The data in
the source file is however not affected.

You can recover the deleted data by choosing Edit:Undo Cut
before performing any other operation. Do not use Edit:Paste
Curve  to recover the deleted section: this will insert the section
as a separate curve. If you have performed another operation
and Undo Cut  is not available, you must re-open the source
file(s) to restore the original curve.
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3.3.2 Adjusting the baseline
Baseline adjustment is one of a set of y-transformations available in
BIAevaluation. Most kinetic evaluation models require a zero baseline
for fitting, so that this step is almost always a preparatory step in
kinetic evaluation.

1. Select a section of the curves to be treated as baseline using the
right mouse button. Make sure that the selection does not extend
outside the baseline region for any curve.

2. Press the Y-Transform  button or choose Calculate:Y-Transform . In
the dialogue box, choose Zero at Average of Selection , and make
sure that Apply to Entire Working Set  is checked.



Data presentation __________________________________________________________________

3-14 BIAevaluation Software Handbook

3. Press Add As New  if you want to have access to both the adjusted
and original curves in the project, otherwise press Replace
Original . The baseline for each curve will be set to zero at the
average y-value within the selection for the curve.

Notes: Replace Original  is generally recommended after a simple
transformation of this kind, to avoid accumulating large
numbers of curves in the project window. However, if you
press Replace Original , the transformation will affect all plots
in all working sets which use the original curves. You are
warned if any of the curves affected is used in more than one
working set.

3.3.3 Aligning curves
X-transformations include a function for aligning curves to a defined
time point. This is valuable for multi-channel applications, where the
injection points on the sensorgrams from different flow cells may be
slightly displaced, and for results files where one sensorgram includes
several injection cycles (typically BIAlite and BIACORE X result files).
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To align curves:

1. Press the X-Transform  button or choose Calculate:X-Transform . In
the dialogue box, choose Curve alignment . Uncheck Replace
Original  if you want to keep the original non-aligned curves. Press
Next>  for the next step in the alignment procedure.

2. This will maximize the plot window for best resolution, and
display the curves with arrow markings on each curve. The
arrows have the same colour as the curves for ease of
identification.

3. Move the arrows on each curves to the point to be aligned
(typically an injection start). Enter a time value in the box at the
bottom of the window if you want the alignment point to be set
to a time other than zero.
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4. Press Finish . The curves will be aligned in the x-direction.

3.3.4 Normalizing curves
You can normalize curves using either the lowest and highest points in
the curve or the lowest and highest points in a selected region. To
normalize using a selected region, select the region of the curves using
the right mouse button before choosing Normalize .

Choose Calculate:Normalize.

Check the boxes as appropriate:

Normalize Selection To Specified Values  specifies that the lowest and
highest points in the selected region will be used for normalization. If
this box is not checked, the lowest and highest points in the entire
curve will be used. Use this function to avoid normalizing to the top
and bottom of response spikes. This box is not available if no data is
selected in the curves.
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Normalize-X , Normalize-Y  selectes normalization in the x-and y-
directions respectively. The Max and Min  values set the scaling for
normalization.

Apply to Entire Working Set  specifies that all curves will be
normalized, using the lowest and highest values in all curves taken
together. If this box is not checked, normalization applies only to the
active curve.

Normalization applied to the entire working set compares the curves
according to values. Normalization applied to individual curves
compares the curves according to shape. Shape comparisons can be
important in cases where the interaction model predicts different
sensorgram shapes (e.g. changes in the shape of the dissociation phase
as a result of varying contact times may indicate heterogeneous
interactions or conformational changes in the surface-bound
complex1).

   

Normalization applied to (left) the entire working set and (right) individual
curves.

                                                  

1 Karlsson, R. and Fält, A. (1997) J. Immunol. Methods 200, 121-133.
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In some cases (particularly data files from BIAlite and BIACORE X
and from interactive method development on all instruments), binding
experiments may be recorded sequentially in a single data file. This
section describes how to prepare separate aligned sensorgrams from
files of this type.

The text file his.txt  supplied with BIAevaluation contains three
sensorgrams in sequence, each consisting of two injections. Follow the
procedure below to construct an overlay plot of the three sensorgrams.

1. Choose File:New  to start a new project.

2. Open the text file his.txt  and load the default curve [his.txt 1_X]
vs [his.txt 1_Y].

3. Select the curve in the project window and press the Overlay plot
button.

3.4 Creating an overlay plot from consecutive injections
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4. Using the right mouse button, select the third cycle. The left edge
of the selection is not critical: you should however make sure that
the selection extends past the end of the curve.

5. Choose Edit:Cut  (keyboard shortcut Ctrl-X) to remove the data,
then choose Edit:Paste Curve  (Ctrl-V) to paste the data back into
the window. In the Paste Curve  dialogue box, choose Original
Position  and check the New Colour  box.
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6. Repeat steps 4 and 5 for the second cycle. You will now have a
plot window where the total curve shape is the same as the
original, but the 3 cycles are identified in different colours
(indicating that the window actually contains 3 separate curves).

7. Choose Calculate:X-Transform.

Select Curve alignment  and press Next> . The curves are displayed
with an alignment marker in the same colour as the curve. Move
the marker to the beginning of the first injection for each curve.
Zoom the display for each curve to set the alignment point with
precision.
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8. Press Finish  to complete the curve alignments.
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Sheet windows are used for several purposes in BIAevaluation:

• opening report point tables for display and evaluation of numerical
result data (e.g. plotting baseline levels against cycle number to
assess regeneration performance, see Section 3.6)

• numerical manipulation of the results obtained from curve fitting
(e.g. calculations performed on fitted constants)

• evaluating data from concentration measurements (Chapter 5) and
from solution affinity determination (Section 6.3)

The spreadsheet supports basic arithmetical operations (+ - / * ^) as
well as a range of functions common to most commercial spreadsheet
programs, like SUM, AVERAGE, COUNT, MAX and MIN. To
perform calculations in the spreadsheet, enter an equals sign (=)
followed by the appropriate expression in a cell. In expressions, cells
are referred to by letter-number coordinates: ranges are specified by
two cell references separated by a colon (:). Use parentheses to specify
priorities in complex expressions. For example:

Expression gives

=A2+B5 the sum of the values in A2 and B5

=A2*B5 the product of the values in A2 and B5

=(A2+B5)/C2 the result of dividing the sum of the values in A2
and B5 by the value in C2

=A2^2 the square of the value in A2

=SUM(A1:A45) the sum of the values in cells A1 to A45 inclusive

=MAX(A1:C45) the highest value in the region defined by A1
(upper left) and C45 (lower right)

Note: The functions supported in the spreadsheet represent a subset
of those in Microsoft® Excel, and use a syntax compatible
with Excel. If you require a special function, try entering the
corresponding Excel formula.

Spreadsheet operations are illustrated here using data from the report
point table conc.rpt , included as an example with BIAevaluation
Software.

3.5 Spreadsheet functions
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3.5.1 Opening data files
To open data files in a spreadsheet window, choose File:Open  (see
Section 3.1). For BIA result files containing report point information,
choose to open the report point table. For saved report point tables
and text files, choose to open the data as a sheet.

Note: Spreadsheets are part of the current project, although they are
not listed in the project window. Saving the project will save
any open spreadsheets in their current state.

3.5.2 Sorting and filtering data
BIAevaluation spreadsheet operations follow the same principles as
operations in Microsoft Excel with respect to selecting and sorting
data, with the following important exceptions:

• Many operations in BIAevaluation can only be applied to entire
rows of data since each row represents one measurement (report
point). For example, sorting data sorts entire rows even if only
certain columns are selected. This ensures that integrity of
experimental data is maintained.

• Dragging marked cells to a new location in the spreadsheet will
overwrite the destination cells without warning. If you move cells in
this way be accident. Choose Edit:Undo  before performing any other
operation.

Sorting data
It is often convenient (although not essential) to sort data in the
spreadsheet. Choose Data:Sort . You can sort data using up to three
sort values in one operation.
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Normally, report point tables have a header row (the first row in the
table contains the column name). With Header Row  checked, columns
for sort values are identified by the column name and the header row
is not moved in the sorting process. With No Header Row  checked,
columns are identified by their column letters and the contents of the
first row in the table are sorted together with the other rows.

Filtering data
Report point tables frequently contain more points than are required
for concentration evaluation. Thus the file conc.rpt , representing
sandwich assay data for determination of β2-microglobulin, includes
report points for baseline, primary response and secondary response.
You can choose to filter the spreadsheet so that you only see and work
with rows that fulfil the filter conditions. For example, for
concentration evaluation from conc.rpt , you may only want to work
with rows showing the secondary response.

Note: When you filter the data in a spreadsheet, all data remains in
the spreadsheet even though only a subset is displayed. You
can display all data again by removing the filter conditions.

To filter data, choose Data:Filter . Choose whether the sheet has a
header row or not: if you choose Header Row , the first row in the
sheet will be treated as a header. If you choose No Header Row , the
first row will be treated as data. Report point tables always have a
header row.



__________________________________________________________________Data presentation

BIAevaluation Software Handbook 3-25

A filter box appears at the head of each column, with a pull-down
menu including the unique values in the column together with the
options All  and Custom . For example, to display only secondary
response values, choose second_AB  from the filter options at the top
of the id  column.

The filter option Custom  allows you to specify a selection condition
for the column, e.g. to eliminate outliers by displaying only response
values that are less than a certain value. For example, to select only
rows with relative response between 100 and 3000, choose Custom  for
the filter for column RelResp  and enter the following conditions in the
dialogue box:

If a custom filter is applied, the option Edit Custom  appears in the
pull-down list of filter options at the top of the column. Use this
option to edit the custom filter settings.

Removing filters
To remove the filter from one column in a filtered spreadsheet, set the
filter condition for the column to All . To remove all filters, choose
Data:Filter .
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Scope of operations on filtered data
Most operations performed on a filtered spreadsheet affect only the
displayed rows. The exception is sorting data, which sorts both the
displayed and the hidden rows together.

3.5.3 Using data in a spreadsheet
You can use the data in a spreadsheet for a variety of purposes:

• Choose Data:Generate Calibration  to create a calibration curve for
concentration measurements (see Section 5.2).

• Choose Data:Calculate Values  to calculate new values based on an
open calibration curve and the values in an existing column (see
Section 5.4.2). This option is only available if one or more
calibration curve windows is open.

• Choose Data:Create Curve  to plot values in one column against those
in another. The plot appears in a new plot window and is entered as
a curve in the project window. An example is given below.

Creating curves from spreadsheet data
BIAconcentration evaluation includes a function for plotting values
from any two columns in a report point table against each other. The
example below illustrates how to assess regeneration performance by
plotting absolute baseline response against cycle number.

1. Open the report point table conc.rpt  and filter the data to select
the value baseline  in the id  column.
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2. Choose Data:Create Curve  and select Cycle for the x-keyword and
AbsResp  for the y-keyword.

The plot is added to the project window. Perform a linear fit on the
plot if you want to draw a straight line through the points.
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4. Evaluating kinetic data

This chapter describes the software tools for evaluating experimental
sensorgram data in terms of a kinetic model. Evaluation procedures are
illustrated by evaluation of the sensorgrams in the example file
kinetics.blr  using a simple model  for 1:1 (Langmuir) binding. Analysis
using other models follows the same principles. Details of the pre-
defined models supplied with BIAevaluation are given in Appendix C.

4.1.1 Opening the project and preparing curves
Open the project kinetics.blr  as a new project (see Section 3.2.1). Select
curves 1-5.

Click on the Overlay plot  button to display the curves in an overlay plot
(see Section 3.2.1).

4.1 Fitting sensorgram data
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4.1.2 Fitting the data
To fit all curves in the working set, make sure that the display is in
overlay mode. If you perform a fit in single plot mode, only the
displayed curve will be fitted.

To simplify evaluation, make sure that the curves are aligned to the
start of injection (see Section 3.3.3). Non-aligned curves can be
evaluated, but selection of data to be fitted is much easier with aligned
curves.

Choose Fit:Kinetics Simultaneous ka/kd  or click on the corresponding
toolbar button. This starts the kinetic evaluation wizard which leads
you through the fitting procedure. The plot window is automatically
maximized for optimal curve display at the beginning of a fitting
procedure.

Evaluation wizard, step 1 – curve adjustments
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This panel reminds you of two prerequisites for successful fitting:

• unwanted data such as regeneration pulses, outlying points and
disturbances in the curves (e.g. air segments) should first be removed.
Disturbances outside the range of data to be fitted should be removed
if they interfere with automatic scaling of the sensorgram display.

• for almost all kinetic models, the baseline prior to injection should be
set to zero.

Both of these operations can be performed without closing the wizard
window. Move the panel to the edge of the screen so that it does not
obscure the curves.

To remove unwanted data, zoom into the area of interest, select the
unwanted data with the right mouse button and click on Cut  in the
wizard panel or press Ctrl-X (the keyboard shortcut for Cut). See
Section 3.3.1 for more details about removing data. Removing data
points or segments from the curves will not affect the fitting procedure,
although it might affect the results.

To adjust the baseline to zero, select the region to be used as baseline
using the right mouse button and click on Y-Transform  in the wizard
panel. Choose Zero at Average Of Selection , make sure Apply to Entire
Working Set  is checked and click on either Replace Original  or Add as
New as required. See Section 3.3.2 for more details about adjusting the
baseline.

Click on Next>  when the curve adjustments have been made.
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Evaluation wizard, step 2 – data selection

From this panel you can set the start and stop times for the injection
and select the data ranges to be used in the fitting. BIAevaluation
suggests start and stop times and data ranges based on the form of the
curves: commonly, these suggestions will need to be adjusted. Do not
continue with the evaluation without inspecting the suggested data
selections and making adjustments where necessary.

Selections are marked on a selection bar at the top of the plot window,
with black lines for injection start and stop and grey bars for selected
data. On all except the currently active curve, injection start and stop
are marked with thin vertical black lines and selected data is marked
with a thicker line. Arrows mark injection start and stop and the
beginning and end of selected data on the currently active curve. Adjust
the injection start and stop points before you adjust the selected data.

To change the selections for all curves together, drag the appropriate
marking on the selection bar. To change selections for one curve only,
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click on the curve to make it active (or select from the curve list in the
toolbar) and drag the appropriate arrows. You may zoom the curve
display to aid in selecting data.

Since BIAevaluation 3.0 can fit data to complex models including mass
transfer-limited binding, it is not necessary to restrict the data selection
to the parts of the sensorgram where binding is kinetically determined.
In general, a short period after the injection start and stop should be
excluded from the fitting to avoid sample dispersion effects. Otherwise,
all of the data may be selected for fitting provided that there are no
obvious disturbances. If desired, separate fits may be performed using
different regions of the association and dissociation phases as a check
that the calculated constants are consistent throughout the sensorgram.

An additional aid in selecting data ranges is split view. This displays the
curves simultaneously with a chosen function of the curve in
synchronized panels, so that zoom and selection functions are applied
automatically to both panels. To enter split view mode, click the
SplitView  button in the wizard panel and select the curve function to
display. See Section 7B.4.9 for a description of the split view functions
and their uses. It may be easier to judge curves in split view if you click
on the Overlay  button to turn off overlay mode. Split view may be
particularly useful in judging whether a simple 1:1 interaction model is
appropriate for the data. The functions ln(dR/dt) and ln(R0/R) are
linear for a 1:1 interaction, constant for mass-transfer limited
interaction and curved for more complex systems.

If you use single plot mode to make interpretation of split view plots
easier, remember to click on the overlay plot button to display all
curves again before continuing.

Click on Next>  when data selection is complete.
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Evaluation wizard, step 3 –model selection

In this panel, you select the model to be used for the fitting and enter
values where necessary for the constants. Values for constants are taken
from keyword values if the constants are defined as keyword-related in
the model (see Appendix B for details of keyword functions).
Concentration is a typical example of such a constant, where analyte
concentration may be included as a user-defined keyword in the report
point table from a BIA analysis. These values are fetched for
convenience only and may be changed if required. For kinetics.blr ,
enter the concentrations as shown in the illustration above.

By default, this panel of the wizard displays only constants which
require input values for the fitting procedure. You may choose to
display all parameters in the model with their initial values by
unchecking the Display constants only  box. Parameters which will be
fitted globally (i.e. with a single value for all curves) are listed as a
single value at the top of the table: cells for the separate curves are
shaded. The reverse applies for constants and parameters defined to be
fitted locally (i.e. with a different value for each curve). In the default
settings for the 1:1 binding model, Conc  is a constant, RI is a local
parameter, Rmax, ka  and kd  are global.
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You can change the status (constant/local fit/global fit) of parameters in
the table using the box under the parameter name. This provides
flexibility in model fitting without requiring definition of multiple
alternative models. Changes you make in this way apply only to the
current fitting and do not affect the model definition.

You can also change the initial value for fitted parameters by entering a
new value in the table. You should normally use the initial values as
defined in the model, although changing the initial values can
sometimes help to achieve a fit for difficult data sets (see Appendix A).

Click on Fit  when you have chosen the model and entered the required
constant values.

4.1.3 Following the progress of fitting

During fitting
During fitting, a small window indicates the progress of fitting both
graphically (with the fitted curves in black) and numerically with the
following information:
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Iteration The number of iterations performed. The number of
iterations required to fit data varies with the data and
the model chosen. The display is updated at a constant
time interval, which may cover a variable number of
iterations.

Depending on the model chosen, the speed of iteration
may vary considerably. Where possible, data is fitted to
integrated rate equations, which is a rapid process.
Where numerical integration is used (See Section A.3),
fitting is significantly slower. In such cases, the first few
iterations use only every tenth point in the selected data
to speed up the approach to fitting. After the first few
iterations, all points are used and the fitting may
become significantly slower.

Max
relative
change

This figure shows the relative change (change/previous
value) in the fitting parameter which varied most during
the most recent iteration, with the name of the
parameter and its current value in parentheses. This
information can help you to judge the progress of the fit.

Chi2 The chi2 (χ2) value is a standard statistical measure of
the closeness of fit (see Section A.5). For good fitting to
ideal data, χ2 is of the same order of magnitude as the
noise in RU (typically <2). However, a few points which
deviate widely from the fitted curve (e.g. air spikes in
the sensorgram) may have a marked effect on χ2.

If the model is simple, fitting may be accomplished so rapidly that it is
difficult to see the contents of the fitting progress box. However, this
box can be useful for following the progress of slower fits.

The fitting process is terminated automatically when a minimum value
is found for χ2. You may terminate a fitting prematurely by clicking on
Accept Fit .
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4.1.4 Examining the completed fit
When fitting is complete, the plot window is replaced by a fit window
which displays the results both graphically and numerically:

Fitted sensorgrams

The top panel in the fit window displays the fitted curves (in black)
overlaid on the original sensorgram curves. Visual assessment of the
deviations between experimental and fitted data is often a good
indicator of the validity of the fitting. In this example, there are clear
systematic deviations in both association and dissociation phases,
indicating that the model is not optimal for the experimental data. (A
closer fit may be obtained by using a mass transfer limited 1:1 binding
model.)

Residual plots

Residual plots are plots of the difference between experimental and
fitted data for each curve. Click on the Residuals  tab at the bottom of
the fit window to display residual plots. An option under
Fit:Preferences  allows you to choose to display residuals as either
absolute values (in RU) or relative values (the residual as a fraction of
the experimental value at each point).

For a perfect fit, the scatter in the residual plots is a measure of the
noise in the signal. Normally, noise levels should be of the order of
± 2 RU, which appears as a scatter in the residual values in this range.
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The form of the residual plot reveals whether there are systematic
deviations between the experimental and the fitted data. In the example
here, the deviations are very clear, particularly in the dissociation
phase. It is easier to detect small systematic deviations from the residual
plots than from the sensorgrams. Systematic deviations indicate that the
model is more or less inappropriate for the experimental data.

If systematic deviations are pronounced, this indicates that the chosen
model may be inadequate or incorrect. Whether refitting the data to an
alternative model is worthwhile depends on the extent of the deviations
and the purpose of the experiment. In general:

• Systematic deviations that are comparable with the noise level may
not represent significant deviations from the chosen model.

• Asymmetrical systematic deviations (as in the illustration above) may
indicate more heterogeneity in the system than in the model.
Symmetrical deviations may often have alternative explanations (e.g.
fitting homogeneous dissociation data to the 1:1 dissociation model
without adjusting the baseline to zero will give a symmetrical
“hammock-shaped” residual plot). Mass transport-limited kinetics
also give rise to symmetrical deviations.

Note: Global fitting procedures generally give higher residual values
than local fitting (Section 4.1.5).

Numerical results
The Report  tab at the bottom of the fit window displays the results of
the fitting in terms of selected parameter values. Parameters that will be
included in the report are defined in the model, and may include
functions of calculated values, e.g. KA and KD derived from the fitted
rate constants (see Appendix B).

The Parameters  tab displays the fitted values for the parameters defined
in the model together with statistical information. Depending on the
option chosen in Fit:Preferences , the statistical value may be either
standard error or T-value (a relative measure of the standard error
defined by dividing the value of the parameter by the standard error).
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The Selections  tab displays the start and stop times for injection and
the selected data ranges used for the fitting. When the Selections  tab is
displayed, the graphical area of the fit window shows the experimental
curves with the selected regions marked.

4.1.5 Assessing the fit
In assessing the results of a fitting, always check the numerical results
for:

• reasonableness – for example, a model fitting which produces
dissociation constants of the order of several s-1 should be regarded
with suspicion, since current BIA technology cannot measure such
rapid dissociation with any confidence.

• consistency – for example if locally fitted constants vary with the
analyte concentration, the model may be inadequate or incorrect (or
the concentration values may include a systematic error).

Visual inspection
Frequently, visual inspection of the experimental curves with overlaid
fitted curves gives a good indication of the goodness of fit. Use the
zoom function to look particularly at the beginning and end of the
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injection to see that the injection start and stop times are correctly
chosen. The illustration below shows the result of fitting the data in
kinetics.blr  with the injection start set a few seconds too early: the
systematic deviation in the fitted curves clearly indicates the source of
the error:

Residual plots give a graphical indication of how the experimental data
deviate from the fitted curve. If you use residuals to assess the goodness
of fit, remember that global fitting procedures generally give higher
residual values than local fitting. This is because global fitting
constrains the fit to the same values for each curve, while local fitting
allows scatter in the fitted values (arising for example from dilution
errors in a concentration series). The figures below compare the results
of fitting the data in kinetics.blr  using global and local fitting of ka and
kd.
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Fitting kinetics.blr  to a 1:1 interaction model using global settings for ka and
kd. The fit is poor, with marked deviations during the dissociation phase and
at the end of the association phase.

Fitting kinetics.blr  to a 1:1 interaction model using local settings for ka and
kd. The fit is apparently much better, but this at the expense of considerable
scatter in the values for ka and kd.
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In general, global fitting is preferable for parameters that should be the
same for all curves (like ka and kd for a simple interaction). You may
however want to perform a local fitting of these parameters if you
suspect a systematic variation in the parameter values. Remember,
however that certain parameters (such as the calculated steady state
binding level Req and bulk refractive index contribution RI) are
expected to vary with analyte concentration.

Fitting statistics
With the large number of data points in BIA sensorgrams, standard
goodness-of-fit statistical parameters are fairly insensitive to the
accuracy of fitting. For this reason, only the χ2 value is provided: even
this is of restricted use in judging the accuracy of fitting. Statistics of
fitting are discussed more fully in Appendix A.

The standard error or T-value for fitted parameters is not an indication
of the goodness of fit. This value indicates how sensitive the fitting is to
changes in the respective parameters: a high standard error (low T-
value) means that the parameter can be varied over a wider range
without significantly affecting the goodness of fit. Use this value
therefore to judge the significance of differences in a parameter
between different fittings. For example, if the standard error for ka is
relatively high, the confidence that can be placed in small differences in
fitted ka values is low. See Section A.5 for a fuller discussion of this
point.

If you are not satisfied with the fit, you can refit the same curves to a
different model, or refit the curves to the same model with different
data selections.

4.2.1 Refitting data
With the fit window active, choose Fit:Kinetics Simultaneous ka/kd  or
click on the corresponding toolbar button. The fitting procedure is
repeated with the omission of step 1 (adjusting the data) since the data
has already been adjusted.

Note: If you want to perform new data adjustment (baseline
adjustment or removal of unwanted data), go back to the
project window and open a new plot window containing the
original curves. Only the first fitting operation on a plot
window includes the curve adjustment step.

4.2 Refitting to a different or modified model
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The steps in the evaluation wizard for refitting data are thus:

Data selection
By default, the selections used for the currently displayed fitting are
used. You may however change these selections freely.

Model selection
By default, the model used for the most recent fitting is used (parameter
status and initial values are however as defined in the model: any local
changes made for the previous fitting are cancelled). You may change
the status and initial values for the existing model or choose a new
model.

When refitting is completed, the results are displayed in the same fit
window. The previous fit is kept in the fit window and can be
redisplayed by choosing it from the Fit  list in the toolbar. One fit
window can contain any number of fits for the same set of curves.

Note: Fits are identified in the Fit  list by a serial number and the
name of the model. Fits performed to the same model with
different parameter status or data selection have identical
names. The parameter status is apparent from the layout of the
Report  or Parameters  tab; the data selection is shown on the
Selections  tab.

4.2.2 Removing a fit from the fit window
To remove a fit from the fit window, display the fit and choose
Edit:Remove Fit . The fit will be deleted from the project.

Mass transfer limitations are among the most common complications in
kinetic binding data. The observed binding rate is limited by mass
transfer if the rate of transfer of analyte to the surface is significantly
slower than the kinetic binding rate. The effect of mass transfer
limitation is to slow down both the association phase (because analyte
does not reach the surface fast enough) and the dissociation phase
(because analyte is not transported fast enough away from the surface
and is thus available for rebinding).The rate of transfer of analyte to the

4.3 Fitting mass transfer-limited binding data
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surface can be increased by increasing the flow rate, and the rate of
kinetic binding can be decreased by reducing the surface binding
capacity. High flow rates and low surface binding capacities are thus
recommended for kinetic work.

Even with these precautions, however, it may be difficult to obtain
binding data with no mass transfer limitations, especially if the analyte
is large (and thus diffuses slowly to the surface) and the association rate
constant is high (so that the kinetic binding rate is high even at low
binding capacities). In general, mass transfer limitations will be most
significant at the beginning of the association phase and towards the
end of the dissociation phase. As the binding proceeds during sample
injection, the concentration of free binding sites on the surface
decreases and kinetic interaction takes over the rate-limiting role.
Conversely, the concentration of free binding sites is lowest at the
beginning of the dissociation phase, minimizing rebinding effects.

BIAevaluation can fit data to models which include mass transfer
limitations: a model for 1:1 interaction with mass transfer is provided
(see Section C.2.3), and mass transfer terms can easily be added to
other models (Section B.1.2). Interpreting the results of fitting data to
mass transfer-limited models requires some care, however. If mass
transfer is the dominant rate-limiting process, the kinetic interaction is
obscured and the values for the association and dissociation rate
constants are practically irrelevant. The fitting procedure will report
values for these constants, but the significance of the values is low. By
the same argument, if the observed binding is limited by kinetic
interaction, the significance of the reported mass transfer coefficient
will be low.

It is therefore important to determine whether the fitted sensorgrams
include significant kinetic data or not. There are several indicators for
this:

• Inspect the T-value (Section A.5.2) for the fitted parameters. This
value is displayed in the Parameters  tab of the fitting results. As a
rule of thumb, if the T-value is less than 10, the significance of the
reported parameter value is low. For fitting to predominantly mass-
transfer-limited data, the T-value for the association and dissociation
rate constants will be low.

• Choose View:Split View  and display the ln(abs(dY/dX))  function.
During the association phase, this function is a straight line with a
negative slope for fully kinetic-limited data. If the function shows a
downward curvature throughout the association phase, there is
significant mass transfer limitation.

• Repeat the fitting using local parameters for ka, kd and Rmax. If the
data is mass transfer limited, these parameters will probably show a
significant scatter (over a several-fold range). This is because fitting to
mass transfer-limited data is largely independent of the values for ka



______________________________________________________________ Evaluating kinetic data

BIAevaluation Software Handbook 4-17

and kd, and the value obtained for Rmax depends on the values found
for the rate constants.

• Repeat the experiment at varying flow rates. If the values obtained
for the rate constants are consistent over a 5-fold range of flow rates
(15-75 µl/min), mass transfer limitations are not serious and the
reported rate constants are significant. If there is a significant
variation with flow rate, the values from the highest flow rate are
most likely (although not certain) to be reliable.

Fitting to simultaneous ka/kd is the recommended method for most
kinetic analyses. The validity of this approach relies however on the use
of identical experimental conditions for both association and
dissociation (if the experimental conditions differ, the rate constants
obtained from one phase may not be valid for the other), and on the
availability of usable experimental data in both phases. Other fitting
methods are available for special circumstances and for fitting non-
kinetic data.

4.4.1 Fitting k a and k d separately
You may choose to fit the association and dissociation phases
separately. This can be necessary if you do not have access to valid data
for one of the phases (e.g. the association phase may be obscured by a
high bulk refractive index pulse) or if different conditions apply during
association and dissociation. Separate fitting of the association phase
requires values for the dissociation rate constant.

Fitting association and dissociation phases separately can use either
local or global settings for parameters. The default setting is local
fitting. Regardless of whether parameters are local or global, the fit is
performed over all displayed sensorgrams simultaneously.

4.4 Other fitting facilities
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Dissociation phase
Choose Fit:Separate ka/kd  or click on the separate ka/kd toolbar button.
Adjust the curves from the first evaluation wizard panel:

In the second panel, select the data and choose Dissociation  under
Type . (The selection bar is by default placed in the association phase:
move it to the dissociation phase.)

The third panel allows you to choose the model from the list of models
defined for separate dissociation. Only 1:1 (Langmuir) dissociation is
included as a pre-defined model. Click on Fit  to perform the fitting.

The fitting results are presented graphically with the fitted curves
overlaid on the experimental curves over the region of data used for
fitting:
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Numerical presentation of the results is similar to that described for
simultaneous ka/kd fitting (Section 4.1.4).

Association phase
Repeat the procedure as described for the dissociation phase, but
choose Association  under Type  in the second wizard panel. In the third
panel, choose the model (only 1:1 (Langmuir) association is included as
a pre-defined model), and enter values for analyte concentration and
kd. Concentration values may be fetched from the result file if report
points include an appropriate keyword (see Section B.2.2). Dissociation
rate constants are fetched from the most recent fit for separate kd.

4.4.2 General fitting
Models for general fitting are designed for fitting non-kinetic curves.
The following models are included:

• 4-parameter equation for curve fitting

• Linear fit (least-squares) for straight line fitting

• Solution affinity (see Chapter 5)

• Steady state affinity (see Chapter 5)
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To perform a  general fit, choose Fit:General  or click on the general fit
toolbar button. Curve fitting to a 4-parameter equation requires initial
values for the 4 constants used in the model (see Section C.4.1).

For curves fitted to simultaneous ka/kd models with several
components (e.g. multiple interacting species, or a simple interaction
with bulk refractive index contribution), curves for the separate
components can be displayed using View:Components  from the fitting
window. The separated components are shown for one sensorgram at
once. The example below is taken from the example file for
heterogeneous analyte zkomp.ble :

The right mouse button menu (see Section 1.1.2) can be used on the
Components  display, allowing you to export the fitted component
curve data to a text file. The data sets in the text file are identified
according to the component names in the model.

By opening the exported text file as curves, you can import the
component curves back into the evaluation project. This can be useful
if you for example want to subtract the fitted bulk refractive index
contribution from the experimental data for presentation purposes:

1.  Fit the sensorgrams and choose View:Components .

2.  Using the right mouse button menu, export the component curves
for each sensorgram.

3.  Open the exported text files as curves in the same project.

4.  For each sensorgram, choose Calculate:Y-Transform  and subtract
the appropriate Bulk & Drift  curve.

4.5 Examining sensorgram components
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You can create secondary plots from data in the fitting results. Choose
Fit:Plot Parameters  and select the parameters to be used for the x- and
y-axes of the plot. The parameters available are those displayed in the
current fitting results tab (report or parameters). The created plot is
added to the current project window.

For example, to plot values of Req against concentration, choose the
report tab in the fitting window (so that Req is displayed) and choose
Fit:Plot Parameters . Choose Conc of analyte  for the x-axis and Req for
the y-axis, then click on OK.

Note that the parameters available for plotting are those in the
currently displayed tab in the fit window.

You can also copy the contents of the current fitting results tab (report
or parameters) to a spreadsheet in BIAevaluation for further processing
as follows:

1. Click in the cell at the top left of the displayed results table (to the
left of the parameter name row) to select the whole table.

2. Choose Edit:Copy  (keyboard shortcut Ctrl-C).

3. Activate the destination spreadsheet (or open a new sheet) and
click in the cell at the top left of the area where you want to paste
the data.

4. Choose Edit:Paste  (keyboard shortcut Ctrl-V). Note that any
existing values in the paste area will be overwritten.

4.6 Creating secondary plots
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BIAevaluation includes a simulator for generating theoretical
sensorgram data from the interaction models used for kinetic analysis.
This can be valuable for investigating how changes in kinetic constants
or other parameters affect the appearance of sensorgrams, and can thus
provide useful information for design of experimental conditions. For
example, if you find that your observed interaction rates are limited by
mass transfer, you can use the simulator to generate a set of curves
representing different ligand immobilization levels (Rmax values) to see
if mass transfer limitations can be avoided by reducing the ligand level.

To simulate kinetic data, choose Fit:Simulate Curve(s) . This starts the
simulation wizard which leads you through the simulation procedure.

Simulation wizard, step 1 – define curve properties

Choose the number of curves to simulate, the preinjection delay
(representing baseline) and the association and dissociation times.

Click on Next>  when you have entered curve properties.

Simulation wizard, step 2 – model selection

Choose the model to be used for simulation and enter values for the
parameters in the table. If you start the simulation wizard from a fit
window, the values obtained for the fitted curves will be suggested by

4.7 Simulating kinetic data
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default. Otherwise, the simulation wizard starts with blank values. You
can change the status (local/global) of parameters in the table using the
box under the parameter name. Changes you make in this way apply
only to the current simulation and do not affect the model definition.

Click on Simulate  when you have chosen the model and entered
parameter values. The simulated curves are added to the current project
and displayed in a new plot window. The curves are named according
to the model from which they were simulated.

To compare simulated curves with experimental data, choose both sets
of curves in the project window and create an overlay plot.

4.8.1 Experimental considerations
Obtaining reliable kinetic values from sensorgram data makes
considerable demands on careful experimental design and execution1.
Sophisticated evaluation software can never be a substitute for careful
experimentation. Some of the most common causes of inadequate data
are summarized below:

                                                  

1 Karlsson, R. and Fält, A. (1997) J. Immunol. Methods 200, 121-133.

4.8 If the data do not fit the model
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Cause Effect Remedy

Impure reagents Heterogeneous kinetics Purify reagents
rigorously

Immobilization
chemistry

Multiple attachment
sites give
heterogeneous ligand

Use directed
immobilization
methods

Non-specific
binding

Heterogeneous kinetics Use a reference cell to
check specificity

Immobilization
level

High Rmax favours
mass transfer
limitations

Keep Rmax as low as
possible

Analyte
concentration

Low or high
concentrations reduce
the amount of kinetic
information obtained

Use analyte
concentrations in the
range 0.1-10 KD

Dilution errors Systematic errors in ka Use calibrated pipettes

Flow rate Low flow rates favour
mass transfer
limitations

Run at flow rates >20
µl/min

Sample
dispersion

Obscures rapid events
at injection start and
stop

Use high flow rates
and Kinject  command.
Load sample carefully
(BIACORE X)

Bulk effects Obscure rapid events
at injection start and
stop

Match refractive index
in sample and running
buffer

4.8.2 If the fitting fails
In some cases, the fitting procedure fails mathematically, with either an
error message or clearly incorrect fitted curves as a result. The most
common causes for this behaviour are:

• Incorrect data selection. You cannot for example fit a decreasing
response to the association phase of a pre-defined model, since the
models do not allow negative association rate constants. Make sure
that you have selected appropriate parts of the sensorgram for
association and dissociation phases.

• Unsuitable initial values for parameters. In some cases, the initial
values for the parameters may be so far wrong that the fitting fails.
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This is often readily apparent from the fitting progress display
(Section 4.1.3): the first attempts at a fitted curve show either zero
response or an immediate off-scale increase, and the fitting process
never “recovers” from the situation. To correct this, repeat the fit
with a large change (several orders of magnitude) in one or more
selected parameters. The appearance of the fitting progress can often
give an indication of which parameter to adjust: for example, if the
first attempts show extremely high initial binding rates, reduce the
initial value for the association rate constant.

4.8.3 Evaluation as an experimental tool
If in spite of careful experimental design the data do not fit the chosen
model adequately, fitting results can give suggestions for further
experimental directions to investigate the nature of the interaction. The
series of fitting attempts described below illustrates the way
BIAevaluation can generate ideas about the nature of the interaction.
See Section 4.2 for a description of how data is fitted to alternative or
modified models.

The sensorgrams were obtained in BIACORE X using a 41,000 dalton
analyte with an amine-coupled peptide ligand. The experiments were
performed using carefully purified analyte. A 1:1 interaction was
expected. The ligand level was low (about 120 RU maximum binding
capacity estimated by injection of 1000 nM analyte) to minimize mass
transfer limitations. Analyses were performed at 5 analyte
concentrations from 5 to 100 nM. The second flow cell was used as a
reference channel and subtracted from the sample channel during the
run: bulk refractive index contributions were therefore expected to be
zero (and were not significant in the reference-subtracted sensorgram).
All fits were performed with the bulk contribution RI set to a constant
value of zero.

1:1 (Langmuir) binding model
Evaluation starts with the simplest model, 1:1 (Langmuir) binding. The
fit is very poor, in both the association and dissociation phases. In
addition, the reported Rmax value is lower than that found
experimentally:
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In order to check whether there is a systematic error in the
concentrations, the fit is repeated with local fitting for ka (the kd value
is independent of concentration and is left as a global parameter).
Plotting ka against concentration with Fit:Plot Parameters  (Section 4.6)
visualizes any correlation between these parameters:
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Although there may be some correlation between ka and concentration
(indicating a possible dilution error in preparing the samples), the
variation in ka values is slight and is not sufficient to explain the poor
fit.

1:1 binding with mass transfer model
The inadequacy of the fit in the dissociation phase is striking – the
experimental curves flatten out much more rapidly than the calculated
curves, indicating that dissociation slows down with time in
comparison with a simple 1:1 interaction. A possible cause of this is
rebinding of analyte during the dissociation phase, which is a result of
mass transfer limitations preventing clearance of free analyte from the
surface. Fitting to a 1:1 interaction with mass transfer improves the
appearance of the dissociation phase slightly, but not nearly enough to
give an acceptable fit:
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Including mass transfer limitations has improved the fit slightly in the
dissociation phase, but by no means enough to be acceptable. The
association phase is hardly improved at all.

Heterogeneous ligand (parallel reactions) model
The shape of the experimental dissociation phase suggests that there
might be more than one process involved. Rebinding (modelled by mass
transfer limitations) is not an adequate explanation. Fitting to a model
for heterogeneous ligand (parallel reactions) was therefore tested:
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The shape of the calculated curves is significantly improved here,
although deviations from the experimental curves are still significant.
The reported parameters show closely similar ka values for the two
ligand components, but the kd values differ by a factor of 10. The total
Rmax value is now 95, closer to the experimentally estimated value.

Examining the residuals for this fitting reveals a general upward trend
in both association and dissociation phases:

Using the model editor, therefore (see Section B.1.3), a linear drift term
was added to the model for parallel reactions. The result is a
reasonably close fit to all of the curves. Note in particular the excellent
fit to the shape of the dissociation phase for all curves:
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Conclusions
Having found a model which fits the experimental data well, the next
step is to ask if the parameters for the model are reasonable and if so
what experiments may be suggested to test the model.

• Is there reason to accept a heterogeneous ligand model? The peptide
ligand was immobilized with amine coupling with potentially
multiple attachment sites. It would be valuable to investigate the
possibility of immobilizing the ligand using a more uniquely directed
method.

• Are the two components reported in the model physically and
biochemically reasonable? Values for ka and kd for both components
are within a reasonable range for this kind of interactant, and also
within the measurement range of BIACORE X. The two components
represent about 66% and 33% of the total analyte binding capacity,
so that contributions from both components are significant. Choosing
View:Components  shows the way the measured response is
distributed between the components of the model:
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•  Is the baseline drift reasonable? Values for the fitted drift parameter
range from about 0.5 to 2 RU/min, which not very serious although it
is fairly high for instrument-related drift in BIACORE X. It would be
worthwhile investigating possible sources of drift in the experimental
setup.

• As mentioned above, there was low but significant binding of analyte
in the reference channel, so that the baseline drift in the reference-
subtracted channel may be related to interaction events on the blank
surface.

In conclusion, fitting attempts in BIAevaluation have suggested that the
ligand may be heterogeneous and that there may be a drift introduced
by subtraction of a response in the reference cell. This clearly indicates
possible directions for future experiments, assuming that the goal of the
experiment is kinetic characterization of the interaction. Note that the
fitting results are not in themselves evidence of ligand heterogeneity,
but generate a hypothesis that may be tested experimentally.
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5. Evaluating concentration data

BIAevaluation includes functions for evaluating concentration data
from report point tables:

• generate calibration curves from standard samples

• calculate unknown concentrations from the calibration curve

• display CVdose and CVresponse profiles

• create curves from data, e.g. baseline response plotted against cycle
number for assessing regeneration performance.

Concentration measurements with BIACORE may be based on binding
level or binding rate determinations. Under conditions of limiting mass
transfer of analyte to the surface, the initial binding rate is
independent of the ligand density and the interaction characteristics,
and depends only on the analyte concentration and mass transfer
properties1. If mass transfer is only partially limiting, concentration
can be determined independently of the binding characteristics from
measurements over a range of flow rates2. Using this latter approach, a
calibration curve is not needed provided that the diffusion coefficient
of the analyte is known.

Binding levels are usually obtained from report points set at a fixed
time after sample injection (usually after the injection is complete to
avoid bulk refractive index contributions). For interactions which are
amenable to kinetic analysis, it is also possible to use kinetic
evaluation to estimate steady state (Req) values. Binding rates may be
obtained from the slope at report points or from the binding level at
specified time intervals. For mass transfer limited binding, the initial
rate can also be obtained from a straight line fit to the early portion of
the association phase, using the general fitting model Linear fit .

However the data is obtained, concentration evaluation is performed
from a spreadsheet in BIAevaluation. To open the data in a
spreadsheet:

                                                  

1 U.S. patent pending. See Karlsson, R. (1993) J. Immunol. Methods 166,
75-84.

2 Richalet-Sécordel, P. M. et al. (1997) Analyt. Biochem. in press.

5.1 Data for concentration evaluation
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• for report point tables in result files, open the result files and choose
Rpoint Table  in the Open  dialogue box (see Section 3.1.2)

• for exported report point tables and text files, open the file and
choose Open as Sheet  in the Open  dialogue box (see Section 3.1.3)

• for data from kinetic fitting, select the contents of the report tab,
press Ctrl-C to copy the data to the clipboard, open a new sheet and
press Ctrl-V to paste the data into the sheet

Once the data is in the sheet, steps in concentration evaluation are as
follows.

1.  Filter the data so that only the standard and unknown values are
shown.

2.  Generate the calibration curve.

3.  Calculate the unknown values. If the unknowns are included in the
data set used to generate the calibration curve, this can be done at
the same time as the calibration curve is generated. Unknowns can
also be calculated at a later time on the basis of the calibration
curve from data in the same or a different sheet.

These steps are described in detail below. The example data is taken
from the example file conc.rpt , which is a report point table from
determination of β2-microglobulin concentration using a sandwich
assay protocol. The primary response obtained from binding β2-
microglobulin to immobilized antibody is amplified by injection of a
second antibody. The second antibody response is used to calculate
concentration.

To prepare the spreadsheet from conc.rpt  for evaluating concentration
based on the secondary antibody response, filter the data to show only
second_AB  in the Id column.

Note: Concentration values for standard points are required for
generating a calibration curve. Normally, these should be
included as a custom keyword in the report point table in the
result file. If concentration values are not included, type them
directly into the spreadsheet before generating the calibration
curve.

Unknown values are identified by non-numerical values
(including blanks) in the concentration value column. Do not
use numerical identifiers for your unknowns, since these will
be interpreted as concentration values. If the unknowns do

5.2 Generating a calibration curve
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have numerical identifiers, either change them to non-
numerical or filter the unknown rows out of the spreadsheet
before generating the calibration curve.

Choose Data:Generate Calibration to generate a calibration curve. If
there is more than one keyword in the Id column, you will be warned
that the report points have not been filtered. You may choose to
continue, but be aware that your calibration curve will probably not
be correct.

Choose the columns to be used for the calibration curve in the
X-Keyword  and Y-Keyword  panels. By default, BIAevaluation suggests
RelResp for the y-axis of the calibration curve and concentration-
related data (labelled e.g. ng/ml or mg/ml) for the x-axis if such can be
found.

Choose the type of fitting to use for the calibration curve. By default,
BIAevaluation uses a 4-parameter equation which gives a robust fitting
for practically all calibration curves. Other fitting functions available
are spline, qubic spline, line and point to point, with or without
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smoothing (see Section 7D.4.4 for details). Use these alternatives only
if you have good reason not to use the 4-parameter equation.

By default, the calibration curve is generated by fitting to all
calibration points, treating replicates as separate points (All  is selected
under Replicates ). If you select Median  under Replicates , the
calibration curve will be generated using the median of replicate values
(the middle point in an odd number of replicates or the average of the
two middle points in an even number) for each standard
concentration. In general, All  is preferable to Median .

If you check Calculate Unk. , BIAevaluation will calculate
concentration values for unknown points using the generated
calibration curve. You can calculate values for unknowns and insert
the results in the original sheet at a later stage, regardless of whether
you calculate unknowns at this stage or not.

You can save the calibration curve in a BIAevaluation project file by
choosing File:Save .

5.3.1 Calibration window components
The calibration curve is displayed in a calibration curve window. The
fitting algorithm used is shown in the panel at the left of the curve
window. There are five buttons in this panel for different display
modes:

Displays the calibration curve.

If the calibration curve is generated using the 4-parameter equation,
values for the parameters used in the fitting (Rhi, Rlo, A1 and A2; see
Section C.4.1) are shown beside the curve.

5.3 Examining the calibration curve



________________________________________________________ Evaluating concentration data

BIAevaluation Software Handbook 5-5

Displays cvX, i.e. a plot of the precision in measured concentration as a
function of the average concentration. cvX values are dependent on
how well the standard curve fits the data.

Displays cvY, i.e. a plot of the precision in measured response as a
function of the average concentration. cvY values are independent of
the curve fitting.
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Displays the calibration data in tabular form. The format for numerical
display can be changed if desired (Section 7E.4.7).

Displays the calculated results for unknown points (only available when
unknowns have been calculated). Results are grouped according to the
value in the concentration column, and averages and CV values are
presented for each group. Values outside the range of the calibration
curve are displayed as #N/A.



________________________________________________________ Evaluating concentration data

BIAevaluation Software Handbook 5-7

5.3.2 Comparing calibrations
If two or more calibration windows are open at the same time, choose
Data:Compare Calibrations  to create an overlay plot of different
calibration curves. The example below compares calibration curves for
the primary response (Id keyword b2micro ) and secondary response
(second_Ab ) in conc.rpt .

The area at the bottom of the window lists the available calibration
curves by window name and title. (Choose Labels  from the View  menu
or the right mouse button menu in the calibration window to set the
title.) You can double-click on the name to change it: changes however
will be lost when you close the window. Check the box beside a
window name to display that calibration curve in the overlay window.
Use the right mouse button menu (Section 1.1.2) if you want to copy
the overlay plot to the clipboard or export the data to a text file, or to
set labels or a legend in the overlay plot window for printing. The
legend uses the names as listed at the bottom of the window. Changes
made to labels and legend are lost when the window is closed.

By checking the Calculate Unk.  box in the dialogue box for generating
a calibration curve, you can calculate values based on the calibration
curve for any unknown points (non-numerical concentration values) in
the data set used for calibration.

You can also calculate values separately, using a calibration curve
prepared on a previous occasion. This is useful if you want to apply

5.4 Calculating unknown values
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the same calibration curve to concentration measurement data in
several data sets. The presentation of calculated unknowns differs
according to whether the operation is requested with a calibration
window or a spreadsheet window active.

5.4.1 Calculating from a calibration window
If a calibration window is active when the unknowns are calculated,
the results will be entered in the unknowns section of the calibration
window. New results will be added to any previously existing results
providing a cumulative report. The spreadsheet window containing the
unknowns must be open.

To calculate new unknown values from the calibration window:

1. With the calibration window active, choose Data:Calculate
Unknowns.

2. Choose the spreadsheet window containing the unknown data.

3. Choose the columns in the spreadsheet containing the
concentration (x-axis) and response (y-axis) values.
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4. Press OK. Unknowns (identified by non-blank, non-numerical
values in the concentration column) will be added to the
unknowns section of the calibration window.

This approach groups the unknown values automatically by identifier
and calculates average and CV values within each group. However,
values are only calculated for points with non-blank, non-numerical
identifiers in the concentration column.

5.4.2 Calculating from a sheet window
Values can also be calculated using a calibration curve by choosing
Calculate Values  from a spreadsheet window. The results will be
entered in the first empty column of the spreadsheet. The calibration
window containing the standard curve must be open.

To calculate values from the spreadsheet window:

1. With the spreadsheet window active, choose Data:Calculate
Values.

2. Choose the calibration window to use for calculating the values.

3. Choose the column in the spreadsheet containing the response (y-
axis) values.
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4. Press Finish . The calculated values will be inserted in the first
empty column in the spreadsheet. Values will be calculated for all
rows displayed in the sheet. Rows where the response value is out
of range for the calibration curve will be marked as #N/A.

Use this approach when you want to calculate values for further
processing, or when you want values for rows which have numerical
identifiers in the concentration column (remember that calculating
unknowns from a calibration window only gives values for points
identified as unknown in the concentration column).
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6. Evaluating affinity data

BIAevaluation supports determination of affinity constants in three
ways:

• calculation from the ratio of fitted rate constants.

• calculation from measured steady state binding levels

• calculation of affinity in solution by using BIACORE to measure the
free concentration of one interactant in an equilibrium mixture

These approaches are described in this chapter.

For a simple interaction, the affinity constant is defined as the ratio of
the forward and reverse rate constants.
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For the pre-defined kinetic evaluation models based on separate 1:1
interactions (1:1 (Langmuir) binding, heterogeneous analyte and
heterogeneous ligand), affinity constants are included in the report
definition in the model, so that kinetic evaluation automatically
provides affinity constants. Bear in mind however that the reliability of
the calculated affinity constants is directly dependent on the reliability
of the kinetic constants (i.e. on the appropriateness of the model and
the quality of the experimental data). Relatively small changes in ka
and kd in opposite directions have a much larger effect on the
calculated affinity constants.

For the predefined models for bivalent analyte and two-state
interactions, the meaning of the affinity constants is less clear. For the
two-state model, an apparent affinity constant is calculated based on
the rate constants for the initial binding and the conformational
change. Calculated constants for the individual steps are easily derived
from the separate fitted rate constants.

6.1 Calculating affinity from rate constants
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The steady state binding level is related to concentration according to
the equation

R
K CR

1+ K Cneq
A max

A

=

where n is a steric interference factor specifying how many binding
sites are on average blocked by binding one analyte molecule (default
value 1). Rmax is the theoretical binding capacity, which will differ
from an experimentally measured value if n is not equal to 1. This
equation is used in the predefined general fitting model for surface
affinity, which may be used to derive affinity constants from Req
values.

Values for Req may be obtained in three ways:

• from report points set on the sensorgrams in the steady state region
of the curve

• from “fitting” a horizontal straight line to a chosen section of the
sensorgrams. A general fitting model for this purpose is included in
the additional model file provided with BIAevaluation, and is
described in Section C.4.4.

• from values calculated from kinetic evaluation of the sensorgrams.
Note that this approach requires that the sensorgrams are amenable
to kinetic evaluation and that the kinetic constants are fitted locally
for each curve. With globally fitted constants, the plot of Req against
C will give a perfect fit by definition.

Proceed as follows to determine affinity constants from measured
steady state binding levels:

1. Obtain steady state binding levels (Req) as described above.

2. Create a plot of Req against C, using Data:Create Curve  if the
values are in a spreadsheet (report point values) or Fit:Plot
Parameters  if the values are in a fitting report.

3. Fit this plot to the general fitting model Steady state affinity .
(Note that you will need to extend the suggested data selection
area to include all points on the curve.)

6.2 Evaluating steady state affinity data
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4. The affinity constant is reported in the fitting results.

Measurement of affinity in solution with BIA is based on
determination of the free concentration of one of the interactants in
equilibrium mixtures. Measurements have to be made on known
concentrations of the free interactant for a standard curve as well as
on the equilibrium mixtures for determination of affinity.

6.3 Evaluating solution affinity data
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If the reaction in solution is written as

A+B = AB

the experiment is designed so that a constant concentration of B is
mixed with a series of known concentrations of A. BIA is used to
measure the remaining free concentration of interactant B. The affinity
constant is calculated using the general fitting model Solution affinity
according to the equation
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where Bfree is the free concentration of component B
A and B are the total concentrations of A and B respectively
KD is the equilibrium dissociation constant for A+B=AB

Follow the procedure below to evaluate solution affinity data. The
illustrations are taken from the example data file SolutionAffinity.ble :

1. Obtain the binding data in a spreadsheet window for
concentration analysis (see Section 5.1). If the data is derived
from curve fitting to sensorgrams, copy the report tab from the
fitting window to a sheet. In this example, the standard samples
are in the same sheet as the unknowns. Cycles 1 to 11 are
measurements on analyte B alone for a calibration curve; cycles
12 to 20 are measurements on 50 nM B mixed with the specified
concentrations of A. The data in the file are simulated.
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2. Filter the data if necessary and choose Data:Generate Calibration .
In the example, the calibration curve is a plot of slope against the
concentration of B. You do not need to calculate unknowns at
this stage.

3. Activate the sheet. Choose Data:Calculate Values  to calculate
concentrations of free B in cycles 12-20 using the calibration
curve and the values in the Slope  column. The calculated values
will be inserted in the first free column in the sheet. Enter a name
for this column in the header row (e.g. Free B).
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4. Select cycles 12-20 in the sheet and choose Data:Create Curve .
Use Free B  as the Y-axis and Conc A  as the X-axis. Check
Selected rows only  so that the points from the calibration curve
are not included. (This is an alternative to filtering the data so
that only the desired rows are displayed.)
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5. Click on the Fit:General  button and fit the curve to the solution
affinity model. Enter a value of 50n for parameter B (the total
concentration of B in the mixtures). The calculated affinity
constant is reported in the fitting results.
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7. BIAevaluation Software
reference

This chapter provides a full reference to BIAevaluation software. Since
the menu options vary according to the currently active window, the
menu descriptions are organized by window type:

• project window Section 7A
• plot window Section 7B
• fit window Section 7C
• sheet window Section 7D
• calibration window Section 7E

BIAevaluation 3.0 is installed as a shortcut in the BIA Programs
section of the Windows 95 Start menu.

Starting from this shortcut opens BIAevaluation with an empty project
window.

BIAevaluation can also be started from a toolbar button in Windows
95-compatible BIACORE Control Software. See the respective
BIACORE Instrument Manual for details.

7.1 Starting BIAevaluation
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BIAevaluation uses the standard Windows 95 graphical environment
with enhanced mouse functionality.

7.2.1 Mouse functions
The following tables summarize the mouse functions in the various
windows in the BIAevaluation workspace:

Project window

Left mouse button Click to select one curve.
Drag or shift-click to select multiple adjacent
curves.
Ctrl-click to select multiple non-adjacent curves.

Double-click to set curve properties.

All graph windows

Right mouse button Click for context menu.

Plot window

Left mouse button Click on a curve to activate the curve.

Double-click on a curve to change curve
properties.
Double-click on an axis to change scale.
Double-click on labels or legend to change.
Double-click on a blank area to unzoom.

Drag to zoom.
Drag on reference line to move reference line.

Right mouse button Click for context menu.

Drag to select data.

7.2 User interface
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Fitting window

Left mouse button Click on a curve to activate the curve.

Double-click on a curve to change curve
properties.
Double-click on an axis to change scale.
Double-click on labels or legend to change.
Double-click on a blank area to unzoom.

Drag to zoom.
Drag on reference line to move reference line.

Right mouse button Click for context menu.

Sheet window

Left mouse button Click to select one cell.
Drag or shift-click to select multiple cells.

Calibration window

Left mouse button Double-click on an axis to change scale.
Double-click on labels or legend to change.
Double-click on a blank area to unzoom.

Drag to zoom.

Right mouse button Click for context menu.
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7.2.2 Entering numerical data
In fitting data to models, numerical input is frequently required for
concentrations, constant values etc. The following shorthand may be
used for numerical input:

Suffix Meaning Normally entered as

a 10-18 e-18

f 10-15 e-15

p 10-12 e-12

n 10-9 e-9

u 10-6 e-6

m 10-3 e-3

k 103 e3

M 106 e6

G 109 e9

T 1012 e12

The shorthand letter must follow the value directly, with no separating
space. The case of shorthand letters is significant (note particularly
that m means milli and M means mega!).

Values can also be entered in standard exponential format. For
example, a concentration of 30 nM may be entered as 3e-8 or as 30n.

This shorthand for numerical values does not apply to the sheet
window.
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7A The project window

The following toolbar buttons are available when a project window is
active. To display a tool tip with a reminder of the button function,
place the cursor on the button and wait for a short time.

File:Open Section 7A.2.3

File:Save Section 7A.2.4

View:Overlay Plot Section 7A.4.2
(Only available when curves are selected.)

7A.2.1 New project
Closes the current project and starts a new project. Before closing, you
will be asked if you want to save changes in the current project.

7A.2.2 New sheet
Opens a new empty sheet window.

7A.2.3 Open (Ctrl-O)  
Opens a file, either replacing the current project or adding curves,
sheets or calibration windows to the current project.

7A.1 Toolbar buttons

7A.2 The File menu (project window)
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You can open the following types of files in BIAevaluation:

• previously saved BIAevaluation projects, including BIAevaluation
version 2.x (extension .ble)

• result files from BIACORE and BIAlite (extensions .blr, .blc, .bls,
.blf)

• report point tables from BIACORE (extension .rpt) or concentration
evaluation files from BIAevaluation version 2.x (extension .clb)

• text files containing tab-separated data (default extension .txt)

See Section Section 3.1 for details of opening different types of files.

7A.2.4 Save  (Ctrl-S) 
Saves the current evaluation project. If the project has previously been
saved, the previous file is overwritten. If the project is untitled (i.e. has
not previously been saved), the Save command is equivalent to Save
As  (see below).

7A.2.5 Save As
Saves the current evaluation project under a new file name. Enter a file
name in the File name  field and change the directory if required in the
Directories  list (see the Windows User Guide for more information on
saving application files).
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Do not specify a file name extension. The default extension will be
used (*.ble).

Projects can only be saved in BIAevaluation file format. Use
File:Export  to save files in other formats.

7A.2.6 Export
Exports selected curves to text files. Specify a file name (default
extension .txt) and change the directory if required.

Data is exported to tab-separated text files which may be opened in
BIAevaluation or in all standard spreadsheet and presentation software
packages.
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7A.2.7 Import Models
Imports evaluation models from BIAevaluation model files (extension
.mdl). This function is only available from the project window.
Choose the file from which to import models:

In the dialogue box, mark the models you wish to import in the
Models list and click on Add=> . To remove models from the list which
will be imported, mark models in the Import  list and click on Remove .
The Clear  button removes all models from the Import  list. Click on the
Import  button to import models in the Import  list.

Note: Models are stored in proprietary format in BIAevaluation
model files. The main use of Import Models  is to move
customized models between installations and to restore
customized models after installation of software upgrades (see
Chapter 2).

Models can be imported to BIAevaluation version 3.0 from
BIAevaluation version 2.2 but not from earlier versions.
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7A.2.8 Export Models
Exports model definitions to a proprietary file format (extension .mdl).
This function is only available from the project window. Use this
function together with File:Import Models  to transfer customized
models between BIAevaluation installations.

Select the models you wish to export in the dialogue box. Mark the
models you wish to export in the Models list and click on Add=> . To
remove models from the list which will be exported, mark models in
the Export  list and click on Remove . The Clear  button removes all
models from the Export  list. Click on the Export  button to export
models in the Export  list, and specify the file name for the exported
models in the dialogue box that follows.

Note: This dialogue box lists all models currently loaded in
BIAevaluation, regardless of type.

7A.2.9 Print (Ctrl-P)
Print  is not available in the project window.

7A2.10 Recent file list
The File  menu lists the four most recently opened files. Click on a file
to open it.
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7A.2.11 Exit
Closes BIAevaluation. If the current project has not been saved since
the last change, you will be asked if you want to save it.

7A.3.1 Cut (Ctrl-X)
Cuts selected curve(s) from the current project and places them on the
BIAevaluation clipboard.

Curves which have been cut from a project window can be pasted
from the clipboard into other project or plot windows.

Note: Curves placed on the BIAevaluation clipboard can only be
pasted into BIAevaluation project, plot or sheet windows. Use
Copy Graph  from the Edit  menu or the right mouse button
menu to place curves on the Windows clipboard for pasting as
graphic objects into other programs.

7A.3.2 Copy (Ctrl-C)
Copy  has the same function as Cut  with the exception that the selected
curve or data is not removed from the window from which the
operation is performed.

7A.3.3 Paste (Ctrl-V)
Pastes the contents of the BIAevaluation clipboard into the current
project as a new curve. The command is only available after curve
data has been copied or cut from a project or plot window.

Data remains in the BIAevaluation clipboard after a Paste  operation
and can be pasted as many times as required into new windows.

7A.3.4 Remove (Del)
Deletes selected curve(s) from the project. Select the curves to delete,
then choose Edit:Remove . Confirm the deletion in the dialogue box.

The removed curves are not placed in the BIAevaluation clipboard
(compare Edit:Cut) .

7A.3 The Edit menu (project window)
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7A.3.5 Curve Properties
Sets the properties of a selected curve for display in the plot and fitting
windows. The properties are:
• curve name
• line type (solid or none)
• colour
• marker type
• marker size

The command operates on the currently selected curve, or on the first
selected curve if more than one is selected.

Double-click on a curve as a short-cut to Edit:Curve Properties .
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7A.4.1 Curve History
Displays the history of selected curve(s), listing all manipulations that
have been performed on the curve.

Click on Print  to print a copy of the curve history.

7A.4.2 Overlay plot 
Opens a plot window containing the selected curves.

7A.5.1 Simulate Curve(s)
Simulates curves according to a chosen model with specified
parameter values. See Section 4.7 for a description of curve
simulation.

When curves are simulated from the project window, default values
are suggested for the number and duration of the curves. The kinetic
parameters for simulation are blank. To simulate curves using values
obtained from sensorgram fitting, choose Fit:Simulate Curve(s)  from
the fit window.

7A.4 The View menu (project window)

7A.5 The Fit menu (project window)
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Default number and duration of curves for simulation.

7A.5.2 Edit Models
Opens the model editor for editing and creating models. Choose the
type of model from the cascade menu:

See Appendix B for a full description of the model editor.

7A.5.3 Preferences
Sets preferences for display of fitting results.

Parameter statistics
Select T-value  or Standard Error . The value for a given parameter
provides an indication of how sensitive the curve fit is to changes in
the parameter (see Section A.5.2). The standard error is expressed in
the same units as the parameter. The T-value is a relative measure of
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the standard error obtained by dividing the value of the parameter by
the standard error. The default setting is T-value .

Residuals
Check the Display relative residuals  box to display residuals as a
fraction of the response value at each point. If this box is not checked,
residuals are displayed in RU. The default setting is unchecked (i.e.
display absolute residuals).

Displayed digits
Choose the number of digits (maximum 9) to display for numerical
fitting results. Results are displayed in exponential format (e.g. 1.2E4
for 12,000) if the number of digits required for the number exceed the
number selected for display. The default setting is 3.

7A.6.1 Cascade
Arranges the currently open windows in an overlapping stack with the
active window at the top of the stack:

7A.6 The Window menu (project window)
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7A.6.2 Tile Horizontal
Arranges the currently open windows horizontally:

If there are more than three windows open, the windows are tiled both
horizontally and vertically to make the best use of the workspace area.

7A.6.3 Tile Vertical
Arranges the currently open windows vertically:

If there are more than three windows open, the windows are tiled both
vertically and horizontally to make the best use of the workspace.
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7A.6.4 Arrange icons
Arranges the icons for any minimized windows at the bottom of the
workspace. This command has no effect on windows that are not
minimized.

7A.6.5 Open window list
The lower part of the Window  menu is a numbered list of all open
windows. Click on a window in this list to activate it.

7A.7.1 About
Displays an information box with the current version of BIAevaluation
and registration details:

7A.7 The Help menu (project window)
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7B The plot window

The following toolbar buttons are available when a plot window is
active. To display a tool tip with a reminder of the button function,
place the cursor on the button and wait for a short time.

– Go to the project window

File:Open Section 7A.2.3

File:Save Section 7A.2.4

File:Print Section 7B.2.7

View:Overlay Section 7B.4.10

View:Reference
Line

Section 7B.4.8

Fit:Kinetics
Simultaneous ka/kd

Section 7B.6.2

Fit:Kinetics
Separate ka/kd

Section 7B.6.3

Fit:General Section 7B.6.4

In addition, the toolbar includes the following selection boxes:

Curve list Selects the active curve

7B.1 Toolbar buttons
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7B.2.1 New project
Closes the current project and starts a new project. Before closing, you
will be asked if you want to save changes in the current project.

7B.2.2 New sheet
Opens a new empty sheet window.

7B.2.3 Open (Ctrl-O)  
Opens a file. See Section 7A.2.3.

7B.2.4 Save (Ctrl-S)  
Saves the current evaluation project. See Section 7A.2.4.

7B.2.5 Save As
Saves the current evaluation project under a new file name. See Section
7A.2.5.

7B.2.6 Export
Exports all curves in the current plot window to text files. If parts of
curves are selected, the selected data is exported for all curves.

7B.2.7 Print (Ctrl-P)
Prints the contents of the current plot window. Choose printing
options from the dialogue box:

7B.2 The File menu (plot window)
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Check Draft  for faster printing. On some printers this may produce a
lower quality printout.

Check Fit To Page  to fit the graph to within the page margins. If this
box is not checked, the graph will be printed with the same
proportions as the screen display.

In the Page Header , the name of the currently active curve (as
displayed in the curve list box) is used as the title. The date refers to
the date of printing.

Click on Setup  to choose the printer and page orientation. This opens
the standard Windows printer setup dialogue, which differs according
to the type of printer connected. The printer settings defined in the
Windows Control Panel apply if settings are not changed in
BIAevaluation.

Click on Margins  to set the page margins.

7B.2.8 Recent file list
The File  menu lists the four most recently opened files. Click on a file
to open it.

7B.2.9 Exit
Closes BIAevaluation.
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7B.3.1 Undo <command> (Ctrl-Z)
Reverses the most recent editing operation in the current session. The
operation that will be undone is identified in the menu (e.g. after a Y-
Transform  operation the command appears as Undo Y-Transform ).

7B.3.2 Redo <command>
Reverses the effect of an Undo  command. The operation which will be
redone is identified in the command (e.g. after a Y-Transform
operation the command appears as Redo Y-Transform ). Redo is
available until the next editing operation is performed.

7B.3.3 Cut (Ctrl-X)
Cuts selected data from the curves in the plot window and places the
data in the BIAevaluation clipboard. All curves currently displayed in
the window are affected. To cut data from one curve only, press the
Overlay  button to switch to single plot mode.

The data can be pasted into the same or a different plot window or a
project window as curves and into a sheet window as numerical data.

Note: The BIAevaluation clipboard is distinct from the general
Windows clipboard, and its contents can only be pasted into
BIAevaluation project or plot windows.

7B.3.4 Copy (Ctrl-C)
Copy  has the same function as Cut  with the exception that the selected
curve or data is not removed from the window from which the
operation is performed.

7B.3.5 Copy Graph (Ctrl-H)
Copies the currently displayed plot to the Windows clipboard, from
which it can be pasted as a graphic into other applications such as
word processing or presentation software. The graph is copied in
Windows clipboard format.

Note: Do not confuse Copy Graph , which copies the whole graph to
the Windows clipboard, with Copy , which copies selected data
to the internal BIAevaluation clipboard.

7B.3 The Edit menu (plot window)
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7B.3.6 Paste Curve (Ctrl-V)
Pastes the contents of the BIAevaluation clipboard into the current
plot window as a new curve. The command is only available after
curve data has been copied or cut from a project or plot window.

Select the position of the curve to be pasted from the dialogue box:

Original position
The curve will be pasted at the x- and y-coordinates from which it was
cut or copied.

Specified position
The curve will be pasted with the first data point at the coordinates
specified. If SpecifiedX  or SpecifiedY  is chosen, the original position
will be used for the unspecified coordinate.

If the New Colour  box is checked, the pasted curve will be assigned a
new colour. Otherwise, the original colour will be used. Checking this
box makes it easier to distinguish the pasted curve in an overlay plot
window.

Note: The curve is always pasted as a separate curve. If you cut a
section from a curve and then paste the section at the original
position in the same window, you will get an apparently
continuous curve (particularly if New Colour  is not checked).
The curve consists however of two sections.

7B.3.7 Remove Selected Data
Deletes selected data from one or more curves in the plot window.
Choose whether to fill the removed section with an interpolated
straight line or to make the data points invalid:



BIAevaluation software reference – the plot window _______________________________________

7-22 BIAevaluation Software Handbook

If you choose to make the data points invalid, the curve will appear
discontinuous. It is however still a single curve, and you can include
part or all of the invalid data in a selection for fitting purposes.

Choosing Edit:Remove Selected Data  and Make Data Points Invalid  is
analogous to Edit:Cut  in the plot window, with the exception that the
removed data is not placed in the BIAevaluation clipboard.

7B.3.8 Curve properties
Sets the properties of a selected curve for display in the plot and fitting
windows. See Section 3.2.2.

7B.3.9 Working Set
Edits the contents of the current working set, allowing you to add and
remove curves. Curves that can be added are those contained in the
current project but not included in the working set. Removing curves
from the working set does not remove them from the project.

To add curves, select the required curves in the Available Curves in
Project  panel and click on Add-> . To remove curves, select curves in
the Curves in Working Set  panel and click on <-Remove . Click on
Clear  to remove all curves from the working set.
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7B.3.10 Select
Selects a section of either the current curve or all curves in the working
set, specified by coordinates on the x-axis.

Enter the limits of the required selection in the From  and To fields.
Check Apply to Entire Working Set  if you want the selection to apply
to all curves in the current working set. If this box is not checked, the
selection will only apply to the currently active curve (as identified in
the curve list on the toolbar). Click on OK to make the selection.

You can also select data by dragging with the right mouse button. Use
Edit:Select  if you want to select between known x-coordinates. Drag
with the mouse if you want to set or adjust the selection limits
visually.

If a section of one or more curves is currently selected, the selection
limits for the active curve are entered by default in the dialogue box.
Click on Remove  to clear the selection.

Notes: If Apply to Entire Working Set  is checked when you click on
Remove , the selections will be cleared from all curves
regardless of the values entered in the From  and To boxes.

If either of the requested selection limits is invalid for any
curve in the working set (e.g. lies outside the limits of the
curve), the actual limit is adjusted to the nearest valid point on
the curve. If both limits are invalid, no selection is made.

7B.3.11 Clear Selection
Clears selections from all curves in the plot window. Choosing this
command has the same effect as choosing Edit:Select , checking the
Apply to Entire Working Set  box then clicking on Remove.
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7B.4.1 Scale
Sets the scale for the plot in the current window. If Auto-X  or Auto-Y  is
checked, the scale for the respective axis will be determined
automatically from the limits of the curve data. The default setting is
Auto .

You can also choose View:Scale  by double-clicking on the x- or y-axis
in the window.

Note: Minimum and maximum values cannot be specified as
negative or zero values for axes with a logarithmic scale.

7B.4.2 Adjust scale
Sets the scale of the x- and y-axis according to the limits of the data
for curves in the window. This operation is equivalent to choosing
View:Scale  and checking the Auto-X  or Auto-Y  boxes.

7B.4.3 Unzoom (Ctrl-U)
Restores the previous display after a Zoom  operation.

To zoom the display, drag with the left mouse button over the area to
be enlarged. Consecutive Zoom  operations are restored in reversed
sequence by repeatedly choosing View:Unzoom  or double-clicking with
the left mouse button in the window.

7B.4.4 Gridlines
Displays gridlines in the current window. Major and minor gridlines
can be set independently for the x- and y-axes.

7B.4 The View menu (plot window)
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Major gridlines appear on numbered axis marks. Minor gridlines
appear on intervening (unnumbered) axis marks. The frequency of axis
marks is set automatically according to the scale of the display.

Note: Setting minor gridlines also displays major gridlines.

7B.4.5 Labels
Sets a title and axis labels for the plot or fitting window. Auto-labels
for the axes are taken from the header in the data file, and are Time (s)
and Response (RU)  for BIA files. The default title is blank.

7B.4.6 Legend
Displays a legend identifying the curves in the plot window. Curves
are identified by a coloured line with the name of the curve as it
appears in the project window. The name can be changed with the
Edit:Curve properties  command.

Choose the placing of the legend from the dialogue box. The legend
will be placed outside the plot area. Choose Hidden  to remove the
legend.
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7B.4.7 Curve History
Displays the history of all the curves in the plot window. See Section
7A.4.1 for details.

7B.4.8 Reference Line  
Displays horizontal and vertical reference lines, with their intersection
on the currently active curve. The coordinates of the intersection are
shown on the status line at the bottom of the screen. As you move the
vertical reference line by dragging with the mouse, the horizontal line
follows the y-coordinate of the current curve.
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7B.4.9 Split View
Displays the current plot in a split view, with the curves in the upper
panel and a selected function of the curves in the lower panel. The
panels are coordinated so that zoom, select and reference line
operations affect both panels simultaneously. It is usually easier to
interpret split view display in single plot mode.

Choose the curve function to display in the lower panel from the
dialogue box:

Off Closes split view mode.

dY/dX Derivative plot. Enter the time window over which the
derivative is to be calculated in the Smoothing Factor
field. A suitable value for BIA sensorgrams is usually 5.
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A value of 0 will simply plot the difference between
each point and the preceding point.

ln(abs(dY/dX)) Logarithmic plot of the absolute value of the derivative.
A logarithmic plot emphasises small values, so that
signal noise is more readily apparent. Note that the
logarithmic plot does not distinguish between positive
and negative slopes in the curves. The smoothing factor
applies as described for dY/dX  above.

ln(Y0/Y) Logarithmic plot of the quotient of a chosen starting
point (Y0) and the y-values (Y). Enter the x-coordinate
of the starting point in the Y0 at X position  field. If the
reference line is displayed when split view is chosen, the
coordinate of the reference line is entered by default in
this field. Use this plot in assessing data for use in curve
fitting (see Section 4.1).

Important: If the Y0/Y quotient is zero or negative, no
data is plotted in the ln(Y0/Y) panel of the split view.
Do not use a starting point with a negative y-value
unless the section of interest in the curve also has
negative y-values.

7B.4.10 Overlay  
Toggles the display between overlay and single plot mode.

7B.5.1 Y-Transform  
Transforms one or more plots in the y-direction. The transformation
operates either on the selected curve or on the entire working set.

After selecting the transformation to perform, press Replace Original
to replace the original curve in the project with the transformed curve,
or press Add As New  to add the transformed curve to the project.

7B.5 The Calculate menu (plot window)
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Zero at Average/Median of Selection
Sets the average or median respectively of the selected region to zero
and shifts the curve accordingly. This transformation is not available if
no data is selected. If Apply to Entire Working Set  is checked, the zero
value is set separately for each curve. Use one of these functions to
correct for differences in absolute baseline values between different
curves (see Section 3.3.2).

Curve - Value
Shifts the curve(s) by subtracting a fixed number from the y-value at
each data point. Specify the amount of the shift in the Value  field. To
add a fixed number, enter a negative number in Value .

Curve * Value
Scales the curve(s) by a fixed factor in the y-direction. Specify the
factor in the Value  field. (Do not confuse this function with View:Scale
which scales the display without affecting the data.)

ln(Curve)
Creates a logarithmic plot by taking the natural logarithm of the
y-value at each data point.

1/Curve
Creates an inverse plot by taking the reciprocal of the y-value at each
data point.

ln(Y0/Y)
Transforms each data point to the value ln(Y0/Y), where Y0 is the
y-value at the reference line and Y is the y-value at the data point. If
the quotient Y0/Y is negative for a given data point, the corresponding
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transformed point is omitted from the resulting plot. This
transformation is only available if the reference line is displayed (see
View:Reference Line ).

This plot can also be displayed in a split view window (see View:Split
View ).

Curve - Curve 2
Creates a difference plot by subtracting the y-value of another
specified curve from the y-value of the curve being transformed for
each data point. Choose curve 2 from the list box. Any curve in the
current project may be used as curve 2, even if it is not included in the
current working set.

7B.5.2 X-Transform  

Transforms one or more plots in the x-direction. The transformation
operates either on the selected curve or on the entire working set.

After selecting the transformation to perform, press Next to go to the
next step in the transformation (for Curve Alignment ) or Finish  to
complete the transformation for other operations.

Curve Alignment
Aligns curves in the x-direction to selected alignment points. See
Section 3.3.3 for details.

Curve - Value at Reference Line
Shifts the curve(s) by subtracting the x-value at the reference line from
the x-value at each data point. This transformation is only available if
the reference line is displayed (see View:Reference Line ).
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Curve - Value
Shifts the curve(s) by subtracting a fixed number from the x-value at
each data point. Specify the amount of the shift in the Value  field. To
add a fixed number, enter a negative number in Value .

Curve * Value
Scales the curve(s) by a fixed factor in the x-direction. Specify the
factor in the Value  field. (Do not confuse this function with View:Scale
which scales the display without affecting the data.)

7B.5.3 Derivatize
Creates a derivative curve. The transformation operates either on the
selected curve or on the entire working set.

After selecting the transformation to perform, press Replace Original
to replace the original curve in the project with the transformed curve,
or press Add As New  to add the transformed curve to the project.

The Smoothing factor  is the window in x-axis units over which the
derivative will be calculated. A suitable value for BIA sensorgrams is
usually 5. A value of 0 will simply plot the difference between each
point and the preceding point.

dY/dX
Plots the first order derivative. This function can also be displayed in
split view mode (Section 5.4.11).

abs(dY/dX)
Plots the absolute value of the first order derivative. This
transformation does not distinguish between positive and negative
slopes in the original curve.

ln(abs(dY/dX))
Plots the natural logarithm of the absolute value of the first order
derivative. This transformation does not distinguish between positive
and negative slopes in the original curve, and visually emphasises low
slope values, so that the transformed plot tends to appear “noisier”.
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This function can also be displayed in split view mode (Section
5.4.11).

7B.5.4 Normalize
Normalizes the curve along one or both axes, so that the curve limits
are adjusted to the specified maximum and minimum values.

After selecting the transformation to perform, press Replace Original
to replace the original curve in the project with the transformed curve,
or press Add As New  to add the transformed curve to the project.

Check the direction(s) in which the normalization is to be performed
and enter the required minimum and maximum values for the
normalization in the respective fields.

If a region of the curve is selected, Normalize Selection To Specified
Values  may be checked so that the limits of the selected region are
adjusted to the specified maximum and minimum values. The rest of
the curve is also transformed accordingly.

If Apply to Entire Working Set  is checked, all curves will be normalized
using the maximum and minimum points in the whole data set. This is
equivalent to scaling all curves. To normalize curves for comparison of
curve shape (see Section 3.3.4), make sure Apply to Entire Working Set
is not checked, or perform the normalization in single plot mode.
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7B.6.1 Simulate Curve(s)
Simulates curves according to a chosen model with specified
parameter values. See Section 4.7 for a description of curve
simulation.

7B.6.2 Kinetics Simultaneous ka/kd  
Starts the wizard for fitting sensorgram data using models for
simultaneous ka/kd. See Section 4.1.2 for a description of the wizard.

7B.6.3 Kinetics Separate ka/kd  
Starts the wizard for fitting sensorgram data using models for separate
ka/kd. See Section 4.4.1 for a description of the wizard.

7B.6.4 General  
Starts the wizard for fitting curve data using models for simultaneous
ka/kd.

7B.6.5 Edit Models
Opens the model editor for editing and creating models. Choose the
type of model from the cascade menu:

See Appendix B for a full description of the model editor.

7B.6.6 Preferences
Sets preferences for display of fitting results. See Section 7A.5.3.

7B.6 The Fit menu (plot window)
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Provides options for arranging windows on the workspace and
activating windows. See Section 7A.6.

Provides information about BIAevaluation 3.0. See Section 7A.7.

7B.7 The Window menu (plot window)

7B.8 The Help menu (plot window)



________________________________________ BIAevaluation software reference – the fit window

BIAevaluation Software Handbook 7-35

7C The fit window

The following toolbar buttons are available when a fit window is
active. To display a tool tip with a reminder of the button function,
place the cursor on the button and wait for a short time.

– Go to project window

File:Open Section 7A.2.3

File:Save Section 7A.2.4

File:Print Section 7C.2.7

View:Overlay Section 7C.4.10

View:Reference
Line

Section 7B.4.8

Fit:Kinetics
Simultaneous ka/kd

Section 7B.6.2

Fit:Kinetics
Separate ka/kd

Section 7B.6.3

Fit:General Section 7B.6.4

In addition, the toolbar includes the following selection boxes:

Fit list Displays fitting results

Curve list Selects the active curve

7C.1 Toolbar buttons
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7C.2.1 New project
Closes the current project and starts a new project. Before closing, you
will be asked if you want to save changes in the current project.

7C.2.2 New sheet
Opens a new empty sheet window.

7C.2.3 Open (Ctrl-O)  
Opens a file. See Section 7A.2.3.

7C.2.4 Save (Ctrl-S)  
Saves the current evaluation project. See Section 7A.2.4.

7C.2.5 Save As
Saves the current evaluation project under a new file name. See Section
7A.2.5.

7C.2.6 Export
Exports all curves in the current fit window to a text file, including
both experimental and fitted curves.

7C.2.7 Print (Ctrl-P)
Prints the contents of the current fit window. Choose printing options
from the dialogue box. See Section 7B2.7 for details.

7C.2 The File menu (fit window)
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The name of the fit as displayed in the fit list on the toolbar is used as
the title in Page Header.

7C.2.8 Recent file list
The File  menu lists the four most recently opened files. Click on a file
to open it.

7C.2.9 Exit
Closes BIAevaluation.
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7C.3.1 Copy (Ctrl-C)
Copies selected data from the numerical display tabs to the Windows
clipboard. Copied data can be pasted into a BIAevaluation sheet
window or into other programs.

Copy  cannot be used on graphical data from the fit window. To copy
fitted curves as graphical objects, use Copy Graph  from the Edit  menu
or from the right button menu. To copy fitted curves as numerical
data, use Export  from the File  menu or from the right button menu.

7C.3.2 Copy Graph (Ctrl-H)
Copies the currently displayed plot to the Windows clipboard, from
which it can be pasted as a graphic into other applications such as
word processing or presentation software. The graph is copied in
Windows clipboard format.

7C.3.3 Remove fit
Removes the currently displayed fit from the fit window.

7C.3.4 Curve properties
Sets the properties of a selected curve for display in the plot and fitting
windows. See Section 3.2.2.

7C.4.1 Scale
Sets the scale for the plot in the current window. See Section 3.2.3.

7C.4.2 Adjust scale
Sets the scale of the x- and y-axis according to the limits of the data
for curves in the window. See Section 3.2.3.

7C.3 The Edit menu (fit window)

7C.4 The View menu (fit window)
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7C.4.3 Unzoom (Ctrl-U)
Restores the previous display after a Zoom  operation. See Section
3.2.3.

7C.4.4 Gridlines
Displays gridlines in the fit window. See Section 3.2.4.

7C.4.5 Labels
Sets a title and axis labels for the fit window. See Section 3.2.5.

7C.4.6 Legend
Displays a legend identifying the curves in the fit window. See Section
3.2.5.

7C.4.7 Curve History
Displays the history of all the curves in the fit window. See Section
7A.4.1.

7C.4.8 Reference Line  
Displays horizontal and vertical reference lines, with their intersection
on the currently active curve. See Section 7B.4.8.

7C.4.9 Components
Displays a breakdown of the fitted curve into components (total,
complex(es) and bulk&drift).
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The right mouse button menu may be used on this window to export
the component curves to text files. The exported files can then be
imported back into BIAevaluation as curves to obtain the component
curves in the project window. This may be used for example to obtain
a curve for bulk and drift effects which may be subtracted from the
experimental curve for presentation purposes with the curve
subtraction function in Calculate:Y-Transform.

7C.4.10 Split View
Displays the current plot in a split view. See Section 7B.4.9.

7C.4.10 Overlay  
Toggles the display between overlay and single plot mode.
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7C.5.1 Simulate curve(s)
Simulates curves according to a chosen model with specified
parameter values. See Section 4.7 for a description of curve
simulation.

When curves are simulated from the fit window, fitted values are
suggested for all parameters in the simulation.

7C.5.2 Plot Parameters
Creates a curve by plotting two chosen parameters from the currently
displayed results tab (report or parameters). This option is not
available if the residuals or selections tab is displayed. See Section 4.6.

7C.5.2 Kinetics Simultaneous ka/kd  
Starts the wizard for fitting sensorgram data using models for
simultaneous ka/kd. See Section 4.1.2 for a description of the wizard.

7C.5.3 Kinetics Separate ka/kd  
Starts the wizard for fitting sensorgram data using models for separate
ka/kd. See Section 4.4.1 for a description of the wizard.

7C.5.4 General  
Starts the wizard for fitting curve data using models for simultaneous
ka/kd.

7C.5.5 Edit models
Opens the model editor for editing and creating models. Choose the
type of model from the cascade menu:

See Appendix B for a full description of the model editor.

7C.5 The Fit menu (fit window)
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7C.5.6 Preferences
Sets preferences for display of fitting results. See Section 7A.5.3.

Provides options for arranging windows on the workspace and
activating windows. See Section 7A.6.

Provides information about BIAevaluation 3.0. See Section 7A.7.

7C.6 The Window menu (fit window)

7C.7 The Help menu (fit window)
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7D The sheet window

The following toolbar buttons are available when a sheet window is
active. To display a tool tip with a reminder of the button function,
place the cursor on the button and wait for a short time.

– Go to project window

File:Open Section 7A.2.3

File:Save Section 7A.2.4

File:Print Section 7B.2.7

Data:Sort Section 7D.4.1

Data:Create Curve Section 7D.4.3

7D.2.1 New project
Closes the current project and starts a new project. Before closing, you
will be asked if you want to save changes in the current project.

7D.2.2 New sheet
Opens a new empty sheet window.

7D.2.3 Open (Ctrl-O)  
Opens a file. See Section 7A.2.3.

7D.2.4 Save (Ctrl-S)  
Saves the current evaluation project. See Section 7A.2.4.

7D.1 Toolbar buttons

7D.2 The File menu (sheet window)
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7D.2.5 Save As
Saves the current evaluation project under a new file name. See Section
7A.2.5.

7D.2.6 Export
Exports the data in the current sheet window to a text file. Use this
function for saving report point tables from result files as text files.

7D.2.7 Print (Ctrl-P)
Prints the contents of the current sheet window. Choose printing
options from the dialogue box.

The name of the sheet window is used as the title in Page Header .

7D.2.8 Recent file list
The File  menu lists the four most recently opened files. Click on a file
to open it.

7D.2.9 Exit
Closes BIAevaluation.
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7D.3.1 Undo (Ctrl-Z)
Reverses the most recent editing operation in the current session.

7D.3.2 Cut (Ctrl-X)
Cuts the contents of the currently marked cells and places them on the
Windows clipboard. Cut data can be pasted into a BIAevaluation sheet
window or into other programs.

7D.3.3 Copy (Ctrl-C)
Copies the contents of the currently marked cells to the Windows
clipboard. Copied data can be pasted into a BIAevaluation sheet
window or into other programs.

7D.3.4 Paste (Ctrl-V)
Pastes sheet data from the Windows clipboard into the current sheet,
with the currently selected cell at the top left of the pasted area. The
current values in the target cells are replaced without warning.

If only a single cell is selected, all of the data in the clipboard is
pasted. If a range of cells is selected when data is pasted, data is only
pasted into the target area.

If the cells contain formulae with relative cell references (e.g. =D2*C2)
are pasted into a BIAevaluation sheet, the relative references are
adjusted according to the paste position. Prefix the column letter
and/or row number with a dollar sign ($) in the formula to specify
absolute references (e.g. =$D$2*$C$2) and prevent adjustment of the
formula. If cells containing formulae are cut or copied from a
BIAevaluation sheet and pasted into another program (including
spreadsheet programs), the value of the formula is pasted.

7D.3.5 Insert Paste
Pastes sheet data from the Windows clipboard into the current sheet,
inserting new rows to accommodate the pasted data. The clipboard
data is pasted with the currently selected cell at the top left of the
pasted area. No data in the target sheet is overwritten.

7D.3 The Edit menu (sheet window)



BIAevaluation software reference – the sheet window _____________________________________

7-46 BIAevaluation Software Handbook

7D.3.6 Clear (Del)
Clears the currently selected cells. The contents of the cleared cells are
not placed on the clipboard, and can only be recovered by choosing
Edit:Undo  (Ctrl-Z) before performing any other operation.

7D.3.7 Delete
Removes the contents of the currently selected cells from the sheet.
Choose the mode of deletion from the dialogue box:

Clear selection contents
This option is equivalent to Edit:Clear.

Delete selected row(s)
Removes the row(s) containing the selected cells.

Delete selected column(s)
Removes the column(s) containing the selected cells.

Note: The option of shifting cells up or left to accommodate cell
deletions that is found in commercial spreadsheet programs is
not supported in BIAevaluation. This ensures that the integrity
of row and column data is maintained.
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7D.4.1 Sort  
Sorts data in the sheet by up to three sort criteria. Choose the
column(s) on which to sort from the dialogue box:

Columns are identified by the content of the first row if Header Row  is
checked. The header row is excluded from the sort. Otherwise
columns are identified by column letter.

7D.4.2 Filter
Filters data in the sheet. When a filter is applied, only rows which
fulfil the filter conditions are displayed. All operations on the sheet
except Sort  apply only to the filtered data: data which is not displayed
in the filtered sheet is not affected by the operation.

Choosing Data:Filter  requires you to specify whether the sheet has a
header row or not:

If a header row is specified, the first row in the sheet will be excluded
from filter operations.

When Filter  is chosen, a pull-down list of filter conditions is inserted at
the top of each column. Each list contains all unique values in the
column together with the entries All  and Custom . Values in the list are
case-sensitive. To display only rows containing a given value in a
chosen column, select the value from the filter condition list at the top

7D.4 The Data menu (sheet window)
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of the column. The example below has been filtered to show only
second_Ab  in the Id column (column L):

To display rows containing a range of values, choose Custom  from the
filter condition list and enter the condition(s) in the dialogue box

If a custom filter is applied, the option Edit Custom  is added to the
filter condition list. Choose this option to change the custom
conditions.

When a filter is applied so that some rows in the sheet are excluded,
the original row numbers are retained. The discontinuities in the row
numbering thus indicate how many rows have been excluded by the
filter.

To remove a filter from a column, choose All from the filter condition
list. To remove all filters, choose Data:Filter : this removes the row
holding the filter conditions and re-displays the unfiltered sheet.
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7D.4.3 Create Curve  
Creates a curve from the values in two columns in the sheet. Choose
the columns to be used for y- and x-values from the dialogue box:

If Header Row  is checked, the first row in the sheet will be excluded
from the curve.

If cells are selected in the sheet, the Selected rows only  option is
available in the dialogue box. Checking this option creates the curve
only from values in the selected rows. Note that it does not matter
which columns are selected: all columns are available for curve data.

7D.4.4 Generate Calibration
Generates a calibration curve from data in the sheet window. If the
sheet is not filtered, you will be warned of this. You can still generate
a calibration curve, but in most situations involving concentration
measurement with BIA the report points should be grouped by Id for
correct generation of a calibration curve.

Choose the columns containing values for the x- and y-axes of the
calibration curve from the respective keyword lists. BIAconcentration
evaluation suggests a concentration keyword (identified as Conc ,
ng/ml , mg/ml  or similar) for the x-axis and relative response (RelResp )
for the y-axis if such keywords can be found.

Choose the fitting function from the Fitting Function  options. The
following options are available. The default choice is 4-Parameter Fit .
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Other functions may be chosen by checking Other and selecting the
function from the list.

4-Parameter Fit Fits the calibration curve to a 4-parameter equation
(see Section C.3.1) which gives good fitting for most
calibration curve data.

Spline Fits the calibration curve to the data points using the
spline fitting algorithm, with or without smoothing
according to the Smoothing  option.

Qubic spline Fits the calibration curve to the data points using a
cubic spline algorithm, with a degree of smoothing as
specified in the Smoothing  box (see Press et al.,
Numerical Recipes in C (Cambridge University Press
1988) for a description of this algorithm). A lower
smoothing factor fits the curve closer to deviating data
points.

Line Fits a linear calibration curve to the data points using
a least squares linear regression algorithm. Smoothing
is not applicable to linear fitting.

Point to point Constructs a calibration curve consisting of straight-
line segments joining adjacent data points. Smoothing
is not applicable to point-to-point fitting.

Replicate values are handled in different ways according to the fitting
function chosen as listed below:

Option Available for
function

Description

All 4-parameter fit Treats each replicate point
separately.

Median 4-parameter fit
Spline
Qubic spline

Fits the curve to the middle point
in the replicates (or the average
of the two middle points if there
is an even number of replicates).

Weighting Spline Uses a replicate weighting
procedure included in the fitting
algorithm.

Average Qubic spline Uses the average value of the
replicates.

If the Calculate Unk.  box is checked, results for any unknown data
points in the table will be generated automatically. See Section 5.4 for
more information about calculating unknowns.
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7D.4.5 Calculate Values
Calculates new values based on a selected calibration curve and the
data in a selected column.

Choose the calibration curve to use from the first dialogue box.
Currently open calibration curves are listed:

Choose the column containing the source values (corresponding to the
y-axis values in the calibration curve) from the second dialogue box:

The new values (corresponding to the x-axis values on the calibration
curve) are entered in the first empty column in the sheet.
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Provides options for arranging windows on the workspace and
activating windows. See Section 7A.6.

Provides information about BIAevaluation 3.0. See Section 7A.7.

7D.5 The Window menu (sheet window)

7D.6 The Help menu (sheet window)
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7E The calibration window

The following toolbar buttons are available when a calibration
window is active. To display a tool tip with a reminder of the button
function, place the cursor on the button and wait for a short time.

– Go to project window

File:Open Section 7A.2.3

File:Save Section 7A.2.4

File:Print Section 7B.2.7

7E.2.1 New project
Closes the current project and starts a new project. Before closing, you
will be asked if you want to save changes in the current project.

7E.2.2 New sheet
Opens a new empty sheet window.

7E.2.3 Open (Ctrl-O)  
Opens a file. See Section 7A.2.3.

7E.2.4 Save (Ctrl-S)  
Saves the current evaluation project. See Section 7A.2.4.

7E.1 Toolbar buttons

7E.2 The File menu (calibration window)
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7E.2.5 Save As
Saves the current evaluation project under a new file name. See Section
7A.2.5.

7E.2.6 Export
Exports the data in the current calibration view to a text file. For
numerical display (calibration and unknown points), values are
exported with 12 decimal places regardless of the current display
format.

7E.2.7 Print (Ctrl-P)
Prints the contents of the current calibration window. Choose printing
options from the dialogue box.

7E.2.8 Recent file list
The File  menu lists the four most recently opened files. Click on a file
to open it.

7E.2.9 Exit
Closes BIAevaluation.



__________________________________BIAevaluation software reference – the calibration window

BIAevaluation Software Handbook 7-55

7E.3.1 Copy (Ctrl-C)
Copies the contents of the currently marked cells to the Windows
clipboard. Copied data can be pasted into a BIAevaluation sheet
window or into other programs. This option can only be used on the
numerical displays (calibration data and unknown points).

7E.3.4 Copy Graph (Ctrl-H)
Copies the currently displayed plot to the Windows clipboard, from
which it can be pasted as a graphic into other applications such as
word processing or presentation software. The graph is copied in
Windows clipboard format. This option can only be used on the
graphical displays (calibration curve, CVx and CVy).

7E.3.6 Clear
Clears the whole unknown points table. This option can only be used
on unknown points display.

7E.3.7 Select all
Selects all cells in the current display. This option can only be used on
the numerical displays (calibration data and unknown points).

7E.4.1 Scale
Sets the scale for the plot in the current window. See Section 3.2.3.
This option can only be used on the graphical displays (calibration
curve, CVx and CVy).

7E.4.2 Adjust scale
Sets the scale of the x- and y-axis according to the limits of the data
for curves in the window. See Section 3.2.3. This option can only be
used on the graphical displays (calibration curve, CVx and CVy).

7E.3 The Edit menu (calibration window)

7E.4 The View menu (calibration window)



BIAevaluation software reference – the calibration window__________________________________

7-56 BIAevaluation Software Handbook

7E.4.3 Unzoom (Ctrl-U)
Restores the previous display after a Zoom  operation. See Section
3.2.3. This option can only be used on the graphical displays
(calibration curve, CVx and CVy).

7E.4.4 Gridlines
Displays gridlines in the current window. See Section 3.2.4. This
option can only be used on the graphical displays (calibration curve,
CVx and CVy).

7E.4.5 Labels
Sets a title and axis labels for the plot or fitting window. See Section
3.2.5. This option can only be used on the graphical displays
(calibration curve, CVx and CVy).

7E.4.6 Legend
Displays a legend identifying the curves in the plot window. See
Section 3.2.5. This option can only be used on the graphical displays
(calibration curve, CVx and CVy).

7E.4.7 Format Number
Sets the display format for numbers in selected cells in the numerical
displays (calibration data and unknown points). Non-selected cells are
not affected. The format is selected from a pre-defined list:

Choose a pre-defined format or enter a format definition in the box
directly below the list.
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Formats are coded using the conventions in Microsoft Excel. By
default, numbers higher than 1 are formatted with two decimal places
(format definition 0.00) and numbers below 1 are formatted in
exponential notation (format definition 0.00E+00). Values which are
invalid (e.g. outside the range of the calibration curve) are displayed as
#N/A. These default settings are sufficient for most purposes.

7E.4.8 Display list
Selects which view of the calibration window to display. These options
correspond to the buttons at the left of the calibration window. See
Section 5.3.1 for details.

7E.5.1 Calculate Unknowns
Calculates unknown values based on the current calibration curve.

Choose the sheet to use from the first dialogue box. Currently open
sheets are listed:

Choose the columns containing the source values (corresponding to the
y- and x-axis values in the calibration curve) from the second dialogue
box. Unknown values are identified by non-numerical values including
blanks in the concentration (x-axis) value column. Note that you may
choose any two columns, not only those used in the original
calibration curve:

7E.5 The Data menu (calibration window)
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The calculated unknowns are added to the unknown display in the
calibration window. New results will be added to any previously
existing results providing a cumulative report.

7E.5.2 Compare Calibrations
Compares two or more calibrations in an overlay plot. See Section
5.3.2 for details.

Provides options for arranging windows on the workspace and
activating windows. See Section 7A.6.

Provides information about BIAevaluation 3.0. See Section 7A.7.

7E.6 The Window menu (calibration window)

7E.7 The Help menu (calibration window)



____________________________________________________________ Principles of curve fitting

BIAevaluation Software Handbook A-1

Appendix A.
Principles of curve fitting

Fitting experimental data to simultaneous ka/kd models in
BIAevaluation relies on two mathematical steps:

• generation of the rate equations for the model used (model
definition)

• finding the values for parameters in the rate equation that best fit the
experimental data (curve fitting)

Rate equations are generated when the model is defined (see Appendix
B). This appendix considers the principles behind the curve fitting
process and their consequences for evaluation of experimental data.

Curve fitting in BIAevaluation relies on the so-called Marquardt-
Levenberg algorithm1, which optimizes parameter values by
minimizing the sum of the squared residuals. The residuals are the
difference between the calculated and experimental curve at each
point: squared residuals are used so that deviations above and below
the experimental curve are weighted equally:

                                                  

1 J. W. Wells, in Receptor-Ligand Interactions, A Practical Approach, ed,
E.C. Hulme.

A.1 Curve fitting algorithms
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where S is the sum of squared residuals
rf is the fitted value at a given point
rx is the experimental value at the same point

The algorithm is an iterative process that begins with an initial value
for each parameter in the equation. These values are defined in the
model (see Appendix B), either as constants or as values at defined
points on the experimental curve (e.g. Ymax, Xmin). The initial values
chosen can in some cases affect the outcome of the curve fitting as
described below. While there is no guarantee that the initial values are
appropriate, the values set in the predefined models in BIAevaluation
give robust curve fitting for most experimental data sets.

It is important to realise that the fitting algorithm is a purely
mathematical procedure that does not have any “knowledge” of the
biological relevance of the values found. For example, the algorithm
itself will not prevent negative values for rate constants, which would
be meaningless in kinetic terms. The model definitions specify whether
negative values are allowed for individual parameters, so that this
particular unreasonable kind of result can be prevented. However, it is
always important to examine the results of a fit for “reasonableness”
of the parameter values.

The fitted curve is generated for each iteration of the fitting algorithm
by calculation from the rate equations for the model (or the fitting
equation for non-kinetic data) using the current set of parameter
values. In kinetic systems, rate equations are fundamentally differential
equations (the rate is the differential of response with respect to time
dR/dt). For a number of models, the differential rate equations can be
integrated to give equations from which the response against time can
be calculated directly.

Other models such as interaction with mass transfer limitations or
two-state processes are described by a set of rate equations which
together are difficult or impossible to integrate mathematically to give
a single expression describing response as a function of time. For these
models, a mathematical tool called a numerical integrator is required
to generate the calculated binding curves. A so-called “stiff” integrator
is required to ensure that data involving rapid binding rates is handled
correctly.

A.2 Generating the fitted curve
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Analytical integration is used in BIAevaluation for models where the
rate equations can readily be integrated, to give rapid fitting of the
data. Numerical integration is much more time-consuming than
calculation from integrated rate equations, but allows evaluation with
models where the rate equations cannot be integrated analytically.

The “best fit” of experimental data to a model is influenced by two
factors:

• the ability of the fitting algorithm to find the true minimum in the
sum of squared residuals function (convergence)

• the number of parameters that can be varied in the model
(complexity)

In finding the best fit, the fitting algorithm scans combinations of
parameter values, searching for the set of values that gives the lowest
sum of squared residuals.

For models with relatively few parameters, there will usually be a
single set of parameter values which gives the best fit, and there will be
no difficulty in finding this set. The fitting is fast and stable. For more
complicated models, there may be more than one local minimum in
the sum of squared residuals. The illustration below shows a three-
dimensional plot of the sum of squared residuals as a function of the
values for two parameters, with two local minima (MIN A and MIN B).
A fit which starts with the initial values represented by point A will
find the minimum MIN A, while a fit which starts at point B will find
MIN B. Depending on the values for the initial parameters, therefore,
this system could give two different “best fits”.

A.3 Finding the best fit
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SS(a)

a1 a2

A
B

MIN A MIN B

In real situations there are many more than two parameters in the
fitting equations, and the potential for different local minima in the χ2

function is greater. In practice the equations used in the predefined
models usually find the minimum sum of squared residuals reliably
provided that the initial values are biologically reasonable. “Incorrect”
local minima are seen either as markedly poor fits or as unreasonable
fitted values. For the majority of sensorgrams, there is considerable
freedom in choice of initial values and there is no reason to change the
values defined in the model. In some rare cases, however, it may be
apparent that the fitting algorithm has difficulty in finding a good fit,
and seems to “get stuck” with wildly wrong fitted curves. In such
cases a large (usually orders of magnitude) change in the initial values
for one or more parameters may help to push the fit towards the true
minimum for the sum of squared residuals. It should be noted however
that difficulty in fitting experimental data to a model is most
commonly caused by poor data quality or a very inappropriate choice
of model, and only rarely by failure of the fitting algorithm.

As the complexity of a model (represented by the number of
parameters involved) increases, the ability to fit the equations to an
experimental curve improves automatically. This is simply because
there is more scope for varying parameters to generate a close fit. It is
very important in evaluating kinetic data to accept the simplest model
which fits the data within the limits of the experiment. A more
complex model may fit the data better, but the crucial question is
whether the improvement is biologically or experimentally significant.

A.4 Model complexity
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At the same time, increasing the complexity of a model increases the
potential for multiple local minima in the χ2 function. This means that
the fitting procedure may be less stable and more sensitive to the
chosen initial values. The injection start and stop times and the range
of data selected may also be critical for fitting to a complex model. It
is important to realise that this decrease in stability of the fitting
procedure as model complexity increases is a property of the
mathematical algorithms used, and does not indicate a defect in either
the experimental data or the evaluation software.

The number of parameters in a fitting is a function of the number of
sensorgrams and the parameter status as well as the complexity of the
model. For example, the simplest model (1:1 binding) has three global
parameters and one local. Global parameters represent for the whole
data set. Locally fitted parameters are treated separately for each
sensorgram. Applying the model to 6 sensorgrams simultaneously gives
the following situation:

Parameter Status No. of variables

Rmax Fitted globally 1

ka Fitted globally 1

kd Fitted globally 1

RI Fitted locally 6

Total 9

If Rmax is also set to be a local parameter, the number of variables
increases to 14.

Fitting several sensorgrams simultaneously to a complex model can
result in a large number of fitted parameters, particularly if several of
the parameters are fitted locally. There is a limit to the number of
parameters that BIAevaluation can handle at the same time. If this
limit is exceeded (as indicated by an error message when the fit is
attempted), either reduce the number of sensorgrams or fit more of the
parameters globally. However, if your experimental system requires
such a complex model, you should seriously consider efforts to
simplify the system. Complex systems are inevitably difficult to
evaluate and interpret, and sophisticated evaluation procedures can
never provide a substitute for careful experimental design.
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A.5.1 χχ2 and correlation coefficient
The closeness of fit is described by the statistical value χ2:

( )
χ 2

f x
2

r r

n - p
=

−∑
1

n

where rf is the fitted value at a given point
rx is the experimental value at the same point
n is the number of data points

and p is the number of fitted parameters

For sensorgram data, the number of data points is very much larger
than the number of fitted parameters in the model, so

n - p  n≈

and χ2 reduces to the average squared residual per data point.

If the model fits the experimental data precisely, χ2 represents the
mean square of the signal noise (since this is the only deviation from
the fitted curve). In practice, values of χ2 below 10 are frequently
acceptable. The form of the fitted curve in relation to the experimental
data (i.e. the shape of the residual plot) is often more valuable in
assessing the goodness of fit than the absolute χ2 value.

In many contexts, the statistical closeness of a curve fit is reported as a
correlation coefficient instead of a χ2 value. BIAevaluation does not
report correlation coefficients because this is a very insensitive measure
of the closeness of fit for a curve with a large number of points.

A.5.2 Standard error and T-value
The standard error reported for each fitted parameter is an estimate of
how sensitive the fitting is to changes in the parameter. The standard
error may be visualized on a χ2 function with the help of the
illustration below.

A.5 Statistical fitting parameters
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SS(a)

a1
a2

In the a1 direction, the χ2 minimum is sharply defined and the
standard error for a1 is low. Conversely, the minimum in the a2
direction is poorly defined and the standard error for a2 is high.

As an alternative under Fit:Preferences , the standard error may be
expressed as a T-value, which is the value of the parameter divided by
the standard error. This is analogous to a signal-to-noise value in a
response. Using the T-value makes it easier to compare standard errors
for parameters with widely different absolute values (e.g. ka and kd).
As a general guide, T-values greater than 10 indicate that the value
obtained for the parameter is significant.

Note that the standard error (or T-value) is not a measure of the
goodness of fit for a given parameter. The goodness of fit is defined by
the depth of the χ2 minimum, while the standard error is a function of
the shape of the minimum. Variations in a parameter with a large
standard error will not affect the goodness of fit to any great extent.

A.5.3 Correlated and non-correlated parameters
Correlated parameters are parameters that are linked to each other in
the set of equations for the model. When two parameters are tightly
correlated, a change in one of the parameters matched by a
compensating change in the other will have no effect on the closeness
of fit. In such a case, it is impossible to decide on absolute values for
the two parameters. For non-correlated parameters, the best fit gives
unique parameter values.
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An example of this behaviour may be found in the number of binding
sites blocked by one analyte molecule (Section B.1.3), when this
parameter is applied to a simple 1:1 binding model. The number of
binding sites blocked is tightly correlated with the association rate
constant and the maximum binding capacity, as shown by the results
below (obtained by fitting the example data set P24.BLE to a 1:1
model with number of binding sites blocked = n. The closeness of fit is
identical in all cases.

N ka kd Rmax χ2

1 2.2 × 105 1.6 × 10-3 90 1.1

10 2.2 × 104 1.6 × 10-3 900 1.1

50 4.4 × 103 1.6 × 10-3 4500 1.1

Clearly, in this example the number of binding sites actually blocked
by one analyte molecule must be known if a meaningful value is to
obtained for ka and Rmax. The dissociation rate constant is however
not correlated with n and gives the same value in all cases.

Parameters which are tightly correlated usually give high standard
errors (low T-values).

A.5.4 Standard deviations for fitted parameters
Parameters which are calculated using global fitting are reported as a
single value for the whole data set. Statistical evaluation of the results
from a single fitting operation is thus neither possible nor meaningful
from a single fitting operation. To obtain statistical values such as
standard deviation for the fitted parameters, results must be calculated
from independent replicate measurements, each evaluated separately.

Even if the fitting is performed with local parameters, it is incorrect to
calculate statistics for the reported values based on evaluation of a
single data set. The results of one concentration series should not be
regarded as replicate measurements on which statistics can be based,
rather as experimental variants designed to extend the data set and
improved the consistency of the results.
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Appendix B.
Editing models

BIAevaluation is provided with a set of pre-defined models for kinetic
evaluation and curve fitting. New models can be created with the
model editor using either an existing model or a blank form as
template. The pre-defined models are write-protected and cannot be
changed or deleted.

Recommendation
Defining models for evaluation of kinetic data requires a good
understanding both of kinetic principles and of the way models are
created in BIAevaluation. Unless you are experienced in kinetic theory,
you are advised to use the model editor only for making minor
changes to existing models, such as

• changing the properties of parameters (e.g. default fitting status)

• adding simple terms such as baseline drift

• changing the pre-defined report parameters

If you do intend to use the model editor to create your own models,
read Section B.2 carefully.
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B.1.1 Opening models for editing
To change a pre-existing model definition, choose Fit:Edit Models  and
select appropriate group of models (Simultaneous ka/kd , Separate
ka/kd  or General ).

Double-click on the model you want to edit or select the model and
choose Edit . In the model editor, change the model name so that you
can save the edited model (you cannot save a model with the same
name as a pre-defined model). You may also change the  model
description of the model: this text is shown for guidance in the model
selection box (see for example the illustration above).

B.1 Making simple changes to existing models
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B.1.2 Changing parameter properties
You can change the status (constant/local fitting/global fitting) and the
initial values for parameters during the fitting procedure (see Section
4.1.2). However, changes made in this way are not saved with the
model, and must be made on every fitting occasion. If you repeatedly
use a pre-defined model with one or more changed parameters, it may
be convenient to define a new model with the required properties.

For example, to change the status of the Rmax parameter from global
to local fitting:

1. Open the model for editing and change the name as described
above (Section B.1.1).

2. Choose the Parameters  tab in the model editor window. Select
the parameter Rmax and set Default Type  to Fit locally :

3.  Press OK to save the changed model.

B.1.3 Adding simple terms
You can add simple terms like baseline drift, bulk refractive index
changes and mass transfer limitations to existing models.

Baseline drift
Follow the procedure below to add a linear baseline drift to an
existing model:

1. Open the model for editing and change the name as described
above (Section B.1.1).

2. Choose the Parameters  tab and click on New to add a parameter
for the slope of the baseline drift. Enter a suitable name for the
parameter:
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3.  Set the properties for this parameter to
Default Type: Fit globally
Initial value: 0.01 [suggested value]
Description: [as appropriate: the description is used as a tool tip in
fitting wizard and results display]

Check the Allow negative value  box.

4. Choose the Bulk And Drift  tab. Check the Drift  box and enter the
expression Drift*(t-tOn)  in the field. The parameters t and tOn  are
reserved parameters for the time and injection start time in
seconds respectively. This expression will therefore produce a
baseline drift which intercepts the sensorgrams at the start of the
injection.

5. Press OK to save the changed model.
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Changes in bulk refractive index
All predefined models include a parameter RI for the bulk refractive
index contribution during sample injection. This parameter is fitted
locally to each curve. BIAevaluation can also handle the situation
where the bulk shifts are different at the beginning and end of the
injection.

Follow the procedure below to define a model with this property:

1. Open the model for editing and change the name as described
above (Section B.1.1).

2. Choose the Parameters  tab and click on New to add a parameter
for the refractive index contribution after the end of the injection.
Enter a suitable name for the parameter:

3. Set the properties for this parameter to
Default Type: Fit locally
Initial value: 10 [suggested value]
Description: [as appropriate: the description is used as a tool tip
in fitting wizard and results display]

Check the Allow negative value  box.

4. Choose the Bulk And Drift  tab. Check the Refractive index (2)
box, and enter the name of your parameter in the Response  field
and tOff  in the From  field. Leave the To field empty. This specifies
that the bulk contribution defined by the new parameter applies
from the end of the injection to the end of the sensorgram (see
illustration below).
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5. Press OK to save the changed model.

Note: If you want to define a model with no refractive index
contribution, uncheck both the Refractive index (1)  and
Refractive index (2)  boxes.

Mass transfer terms
You can include mass transfer of analyte to the surface in any model
as follows:

1. Open the model for editing and change the name as described
above (Section B.1.1).

2. Choose the Parameters  tab and click on New to add a parameter
for the rate constant for mass transfer of analyte to the surface.
Enter a suitable name for the parameter (e.g. kt ).

3. Set the properties for this parameter to
Default Type: Fit globally
Initial value: 0.1 [suggested value]
Description: [as appropriate: the description is used as a tool tip
in fitting wizard and results display]

4. Choose the Reactants  tab, select the analyte (A) and check the
Mass transfer  box. Enter the parameter name for the mass
transfer constant in the field.
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5. Press OK to save the changed model.

Note: The mass transfer constant kt obtained from this model is an
empirical constant which is related to the generally accepted
mass transfer coefficient km by the expression:

kt ≈ 109 × MW × km
Values for kt are typically of the order of 108 for proteins of
molecular weight 50-100 kilodaltons.

Number of blocked sites
You can allow for analytes which block more than one ligand site by
steric interference (note that this is distinct from analytes binding to
more than one ligand site, which is represented by the bivalent analyte
model):

1. Open the model for editing and change the name as described
above (Section B.1.1).

2. Choose the Parameters  tab and click on New to add a parameter
for the average number of ligand sites blocked by each analyte
molecule. Enter a suitable name for the parameter:

3. Set the properties for this parameter to
Default Type: Fit globally
Initial value: 1 [suggested value]
Description: [as appropriate: the description is used as a tool tip
in fitting wizard and results display]
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4. Choose the Reactants  tab, select the analyte (A) and check the
No of blocked sites  box. Enter the parameter name for the rate
constant in the field.

5. Press OK to save the changed model.

Note: Unless the analyte is known from independent evidence to
block more than one binding site, the number of blocked sites
should only be used for models involving several analytes
which block different numbers of sites (see the model for
heterogeneous analyte as an example). Introduction of the
number of blocked sites n in a model with only one analyte
will scale the association rate constant by 1/n and the Rmax
value by n, without affecting the closeness of fit.

B.1.4 Changing report parameters
The parameters displayed in the Report  tab in the fitting window are
defined in the model. You must change the model definition to change
these parameters.

Follow the procedure below to change report parameters:

1. Open the model for editing and change the name as described
above (Section B.1.1).

2. Choose the Report tab.

3. To delete a parameter, click on the row number to select the row
containing the parameter and press Del on the keyboard. Choose
All  in the Clear  dialogue box and click on OK.
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Note: Always choose All  or Values  in this dialogue box.
Choosing Formats  will not delete the entries.

4. To add a new parameter, enter a name and value in the first
empty row in the list. The name will appear in the header row in
the report tab. The value is an expression using the parameters
defined in the model.

5. Press OK to save the changed model.
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You can create new models with the method editor, using either a
blank definition or an existing model as a template.

Caution!
Do not attempt to create models unless you understand the
principles of kinetics. The only way you can check that your model
is correct is to examine the rate equations generated by the model.

B.2.1 Conventions in model definition
For simultaneous ka/kd fitting, BIAevaluation uses a model editor
based on a reaction scheme for ease of use. The reaction scheme is
defined in terms of analyte (in solution), ligand (immobilized on the
surface) or complex (formed on the surface) using the conventions
listed below. Required properties must be entered for all species; other
properties are either required in special cases or optional.

Species Identification Required
properties

Other
properties

Analyte Injected in solution.
Concentration
constant during
injection.

Concentration
Injection start
and stop

Mass transfer
Molecular
weight*
No. of blocked
sites

Ligand Immobilized on the
surface.

Binding
capacity

At molecular
weight*

Complex Formed on the
surface.
Initial concentration
= 0.

Generates
response
(yes/no)

Molecular
weight*

*Molecular weight information is used for heterogeneous analyte
models only and should not be used in other circumstances.

The reaction scheme supports up to 5 first order (A = B) and second
order (A + B = AB) reactions.

Note: The concentration of analyte is always constant, and models
may not explicitly include expressions for changing the
analyte concentration. If such a model is required (e.g for a
situation where a solution reaction is occurring in parallel
with the binding of analyte to the surface), a suggested work-
around is to define the variable-concentration analyte as a
complex which does not generate response (in the scheme
below, A is the injected analyte, with constant concentration;
A1 is defined as a complex which does not generate response):

B.2 Creating new models
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B.2.2 Creating models for simultaneous ka/kd
Follow the steps below to create a new model (the illustrations show
how the pre-defined model for heterogeneous ligand – parallel
reactions is constructed):

1. Choose Fit:Edit models  and choose the type of model you wish to
create (Simultaneous ka/kd , Separate ka/kd  or General ). If you
want to use an existing model as a template, select the model.
Click on New and enter a name and description for the model.

If you choose not to use a template, the model editor will be
opened with a simple interaction for reactants A (analyte), B
(ligand) and AB (complex) pre-defined. No parameters are
defined. You may remove the predefined reactants if you want to
use other names.
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2. In the Reactants  tab, click on New to add new reactants. For each
reactant, choose whether it is analyte, ligand or complex (see
Section B.2.1) and enter an identifier for the reactant. Enter
parameter names or expressions for the reactant properties.

Note: Numbers are used as part of the identifier, not in the
conventional chemical sense of stoichiometry. Thus a
complex named AB2 does not imply two molecules of B
binding to one of A.
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3. Enter the reaction scheme using the pull-down list for each
reactant. To remove a reactant from a box in the scheme, select
the box and press Del on the keyboard. Enter parameter names
for the forward and backward rate constants for each line in the
reaction scheme. (The terms k-forward  and k-backward  apply to
the reaction as entered in the scheme, reading from left to right).
You can also enter mathematical expressions or constant values
for the rate constants.

4. Click on the Parameters  tab and define the parameters used in the
reaction scheme. If you have only used single parameter names
(as opposed to expressions) for the rate constants and properties,
you can click on Rate eq’s  as a shortcut to defining parameters.
BIAevaluation will then enter suggested definitions for all
undefined parameters. This shortcut cannot be used if you have
entered expressions.

For each parameter, define the properties as follows:

Default Type Fit globally, fit locally or constant.

Initial value Starting value for fitted parameters, suggested
value for constants. Leave blank for constants
which are attached to keywords.

Description Text description, used as a tool tip in the
fitting wizard.

Allow negative
value

Check this box if negative values are allowed.
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Attach to
keyword

BIAevaluation “remembers” values on a
curve-by-curve basis for parameters that are
attached to keywords within a session, and
suggests these values for each fitting. In
addition, if the parameter name is used as a
keyword in a BIA result file, the values in the
keyword column of the report point table will
be assigned to the parameter in BIAevaluation
when the result file is opened. A typical
example is the parameter Conc , allowing
concentration values entered in the method for
the BIA analysis and imported automatically
to BIAevaluation.

5. Click on the Bulk and Drift  tab and enter details for bulk
refractive index contribution. See above (Section B.1.2) for a
description of these parameters.

6. Click on the Report  tab and enter definitions for parameters to be
displayed in the fitting report.

7. Click on Rate Eq’s  to display the equations generated by
BIAevaluation, and check these for consistency with the intended
model (see Section B.2.3).
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You can select the equations in the display and click on Copy  to
copy the equations to the Windows clipboard. Use this function
and paste the equations in to e.g. Wordpad to print a copy of the
rate equations.

8. Click on OK to save the new model.

B.2.3 Checking the model
BIAevaluation will not let you save a model that is mathematically
incorrect. If rate equations cannot be generated (e.g. because of a
missing parameter definition), the model cannot be saved.

A model which is internally consistent is however not necessarily
correct. There are two ways of examining a new model for
correctness:

1. In the model definition dialogue box, click on Rate eq’s  and
examine the generated equations carefully. The equations are
presented as differential equations for the rate of change of
components in the interaction. For example, the rate equations
for a simple 1:1 interaction are presented as:
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You should preferably derive your own rate equations from the
model you intended to define and compare these with the
equations generated by BIAevaluation. Pay particular attention to
the units implied for the various parameters in the equation,
remembering that the ultimate units for the total response must
be in RU/s.

2. Use the simulator to generate sensorgrams for your model (see
Section 4.7). Enter parameter values that are typical for your
system and ensure that the simulator generates reasonable
sensorgrams. This approach can be useful for checking that the
parameters are written with correct units, since mistakes in this
respect will often result in errors of several orders of magnitude.

Important!
Apart from careful attention to the model definition and the aids
mentioned above, there is no way to check that the model as entered
correctly describes the required interaction situation. A good
understanding of kinetics is therefore essential for creation of new
models.

B.2.4 Creating models for separate ka/kd and
general fitting

For separate ka/kd and general fitting, models are defined in terms of
integrated rate equations or general equations. The reaction scheme is
not used.

Models of this type are defined using the Parameters  and Report  tabs
only (see steps 4 and 6 in Section B.2.2). The editor window has a field
for the fitting equation and an identification of the independent
variable. The equation is written as a formula expressing the ordinate
(y-values) as a function of the independent variable (x-values). For
fitting sensorgram data to rate equations (kinetics with separate
ka/kd), the formula must represent the integrated rate equation, and
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the independent variable is always time (see illustration below). This
kind of model cannot be used for rate equations that cannot be
integrated.

For general fitting models, any expression may be used in the formula.
The example below shows the model definition for a linear fit
(y=kx+m):
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Appendix C.
Predefined models

This appendix describes the predefined models and example data files
provided with BIAevaluation. For details of how each model is
defined, open the model in the model editor and examine the
definition screens. For conventions in model definition, see Section
B.2.1.

The models included in BIAevaluation are:

Simultaneous ka/kd
• 1:1 (Langmuir) binding
• 1:1 binding with drifting baseline
• 1:1 binding with mass transfer
• Bivalent analyte
• Heterogeneous analyte – competing reactions
• Heterogeneous ligand – parallel reactions
• Two-state reaction (conformation change)

Separate ka/kd
• 1:1 (Langmuir) association
• 1:1 (Langmuir) dissociation

General
• 4-parameter equation
• Linear fit
• Solution affinity
• Steady state affinity

Additional models that can be imported into BIAevaluation are
provided in the file MORE MODELS.MDL. These are:

• 1:1 binding with exponential baseline drift
• 1:1 binding with mass transfer, km(m/s)
• 1:1 (Langmuir) association (kobs)
• Average

More models may be published as they are developed on the BIAweb
Internet site (http://www.biacore.com).

Example data is provided for several of the models in the form of
BIAevaluation project files. Values for all constants required for fitting
to the respective models have been entered in the example data files.
Unless otherwise stated, the example data is obtained from actual
BIACORE runs.
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C.1.1 1:1 (Langmuir) binding
This is the simplest model for 1:1 interaction between analyte and
immobilized ligand, and is equivalent to the Langmuir isotherm for
adsorption to a surface.

Reaction scheme and reactants

Species Type Comments

A Analyte –

B Ligand –

AB Complex –

Bulk and drift

Bulk refractive index contribution RI during sample injection.
No drift.

C.1 Models for simultaneous ka/kd
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Parameters
Parameter Description Fitting status Comments

tOn Starting time for
sample injection (s)

Constant

tOff Ending time for
sample injection (s)

Constant

Conc Analyte concentration
(M)

Constant Attached to
keyword

Rmax Maximum analyte
binding capacity (RU)

Fit globally

ka Association rate
constant (M-1s-1)

Fit globally

kd Dissociation rate
constant (s-1)

Fit globally

RI Bulk refractive index
contribution (RU)

Fit locally Negative
values allowed

Rate equations

Calculated report parameters
The fitting report also includes values for selected parameters.

Parameter Value Description Status

KA (1/M) ka/kd Equilibrium binding
(affinity) constant

Global

KD (M) kd/ka Equilibrium dissociation
constant

Global

Req (RU) ka*Conc*Rmax/
(ka*Conc+kd)

Steady state binding level Local

kobs (1/s) ka*Conc+kd Observed rate constant
(slope of ln(dR/dt) against t)

Local
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Example data
BIAevaluation project file Langmuir\P24.ble .

Note: The closeness of this fit for this example data can be improved
slightly by setting Rmax to a local parameter. This is
experimentally justified since the data was obtained from
binding HIV p24 protein to monoclonal antibody captured on
a rabbit anti-mouse Fc (RAM-Fc) surface, so that the level of
captured antibody may vary slightly between sensorgrams.

C.1.2 1:1 binding with drifting baseline
This model describes a 1:1 interaction superimposed on a linear
baseline drift. Instrument drift is normally low in BIACORE systems
(typically less than 0.005RU/s) and can largely be eliminated by the
use of a reference cell, but the use of a model which includes linear
drift may be appropriate in experiments with low surface binding
capacity (Rmax 100 RU or less). A model with exponentially drifting
baseline, which may be used as an approximation to a capturing
situation with slow dissociation of capturing molecule, is provided in
the additional models file (see Section C.4).

Reaction scheme and reactants

Species Type Comments

A Analyte –

B Ligand –

AB Complex –
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Bulk and drift

Bulk refractive index contribution RI during sample injection.

Drift in RU = Drift*(t-tOn)
where Drift is the rate constant for linear drift (RU/s)

tOn is the injection start time

This expression produces a drift component which has a value of zero
at the injection start. The drift may be positive or negative.

Parameters
Parameter Description Fitting status Comments

tOn Starting time for
sample injection (s)

Constant

tOff Ending time for
sample injection (s)

Constant

Drift Slope of the baseline
drift (RU.s-1)

Fit locally Negative
values allowed

Conc Analyte concentration
(M)

Constant Attached to
keyword

Rmax Maximum analyte
binding capacity (RU)

Fit globally

ka Association rate
constant (M-1s-1)

Fit globally

kd Dissociation rate
constant (s-1)

Fit globally

RI Bulk refractive index
contribution (RU)

Fit locally
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Rate equations

Calculated report parameters
The fitting report also includes values for selected parameters.

Parameter Value Description Status

KA (1/M) ka/kd Equilibrium binding
(affinity) constant

Global

KD (M) kd/ka Equilibrium dissociation
constant

Global

Req (RU) ka*Conc*Rmax/
(ka*Conc+kd)

Steady state binding level Local

kobs (1/s) ka*Conc+kd Observed rate constant
(slope of ln(dR/dt) against t)

Local

Example data
None provided.
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C.1.3 1:1 binding with mass transfer
This model describes a 1:1 interaction with a simplified expression for
mass transfer limitation. An alternative model for mass transfer-
limited interactions is provided in the additional models file (Section
C.4).

Reaction scheme and reactants

Species Type Comments

A Analyte Mass transfer limited, see note.

B Ligand –

AB Complex –

Note: Mass transfer limitation is included by checking the Mass
transfer  box in the analyte properties.

Bulk and drift

Bulk refractive index contribution RI during sample injection.
No drift.
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Parameters
Parameter Description Fitting status Comments

tOn Starting time for
sample injection
(s)

Constant

tOff Ending time for
sample injection
(s)

Constant

Conc Analyte
concentration (M)

Constant Attached to
keyword

Rmax Maximum analyte
binding capacity
(RU)

Fit globally

ka Association rate
constant (M-1s-1)

Fit globally

kd Dissociation rate
constant (s-1)

Fit globally

RI Bulk refractive
index contribution
(RU)

Fit locally

kt Rate constant for
mass transfer (s-1)

Fit globally See comment
under rate
equations

Rate equations

Notes: Introduction of mass transfer limitation (by checking the Mass
transfer  box) introduces an expression for dA/dt , the rate of
change in concentration of analyte A. In the rate equations, A
represents the analyte close to the surface which is capable of
binding to ligand. The basic assumption of constant analyte
concentration in BIAevaluation (see Section B.2.1) is
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maintained insofar as the constant value Conc  represents the
bulk concentration of analyte.

The mass transfer constant kt obtained from this model is an
empirical constant which is related to the generally accepted
mass transfer coefficient km by the expression:

kt ≈ 109 × MW × km
Values for kt are typically of the order of 108 for proteins of
molecular weight 50-100 kilodaltons.

Calculated report parameters
The fitting report also includes values for selected parameters.

Parameter Value Description Status

KA (1/M) ka/kd Equilibrium binding
(affinity) constant

Global

KD (M) kd/ka Equilibrium dissociation
constant

Global

Req (RU) ka*Conc*Rmax/
(ka*Conc+kd)

Steady state binding level Local

kobs (1/s) ka*Conc+kd Observed rate constant
(slope of ln(dR/dt) against t)

Local

Example data
BIAevaluation project file Mass Transfer\Igf1.ble .

C.1.4 Bivalent analyte
This model describes the binding of a bivalent analyte to immobilized
ligand, where one analyte molecule can bind to one or two ligand
molecules. Binding to the first ligand molecule is described by a single
set of rate constants, so that the two sites on the analyte are equivalent
in the first binding step. Binding of the second ligand molecule is
described by a second set of rate constants, allowing the model to take
cooperative effects into account. If the two sets of rate constants are
the same, there are no cooperative effects and the increased affinity
resulting from bivalent binding is frequently referred to as avidity.

The model may be relevant to studies among others with signalling
molecules binding to immobilized cell surface receptors (where
dimerization of the receptor is common) and to studies using intact
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antibodies binding to immobilized antigen. Bear in mind however that
the association rate constant for the second site interaction is reported
in the unconventional units of RU-1s-1 (see below).

If you fit experimental data to this model, use View:Components  to
examine the relative contributions of first and second site binding to
the fitted curves.

Reaction scheme and reactants

Species Type Comments

A Analyte –

B Ligand –

AB Complex Formed by binding one A to B

AB2 Complex Formed by binding one A to AB

Bulk and drift

Bulk refractive index contribution RI during sample injection.
No drift.
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Parameters
Parameter Description Fitting status Comments

tOn Starting time for
sample injection (s)

Constant

tOff Ending time for
sample injection (s)

Constant

Conc Analyte concentration
(M)

Constant Attached to
keyword

Rmax Maximum analyte
binding capacity (RU)

Fit globally

ka1 Association rate
constant for A+B=AB
(M-1s-1)

Fit globally

kd1 Dissociation rate
constant for AB=A+B
(s-1)

Fit globally

ka2 Association rate
constant for
AB+B=AB2 (RU-1s-1)

Fit globally See note

kd2 Dissociation rate
constant for
AB2=AB+B (s-1)

Fit globally

RI Bulk refractive index
contribution (RU)

Fit locally Negative
values allowed

Note that the association rate constant for the second site binding is
in RU-1s-1, not M-1s-1. This is because the reaction involves complex
(in RU) binding to ligand (in RU).

Rate equations
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Calculated report parameters
The fitting report includes values for selected parameters.

Example data
None provided.

C.1.5 Heterogeneous analyte (competing reactions)
This model is intended for analysis of the kinetics of interaction of
mixtures of two analytes. A common application is determination of
the kinetics for a low molecular weight analyte binding to immobilized
ligand, deduced from measurements of binding of a competing high
molecular weight analyte. Response contributions from both analytes
are taken into account, although the high molecular weight analyte is
responsible for the dominant component in the observed sensorgrams.

Concentrations and molecular weights are required for both analytes.
If absolute molecular weights are not known, relative values can be
entered without affecting the outcome of the fitting. The model cannot
evaluate interactions where the proportions and relative sizes of the
analytes are unknown.

If you fit experimental data to this model, use View:Components  to
examine the relative contributions of the two analytes to the fitted
curves.
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Reaction scheme and reactants

Species Type Comments

A1 Analyte –

A2 Analyte

B Ligand –

A1B Complex Formed by binding A1 to B

A2B Complex Formed by binding A2 to B

Bulk and drift

Bulk refractive index contribution RI during sample injection.
No drift.
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Parameters
Parameter Description Fitting status Comments

tOn Starting time for
sample injection (s)

Constant

tOff Ending time for
sample injection (s)

Constant

Conc Analyte concentration
(M)

Constant Attached to
keyword

Rmax Maximum analyte
binding capacity (RU)

Fit globally

ka1 Association rate
constant for
A1+B=A1B (M-1s-1)

Fit globally

kd1 Dissociation rate
constant for
A1B=A1+B (s-1)

Fit globally

mw1 (Relative) molecular
weight of A1

Constant

n1 Number of binding
sites blocked by A1

Constant Default value
1

ka2 Association rate
constant for
A2+B=A2B (M-1s-1)

Fit globally

kd2 Dissociation rate
constant for
A2B=A2+B (s-1)

Fit globally

mw2 (Relative) molecular
weight of A2

Constant

n2 Number of binding
sites blocked by A2

Constant Default value
1

RI Bulk refractive index
contribution (RU)

Fit locally Negative
values allowed
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Rate equations

Calculated report parameters
The fitting report also includes values for selected parameters.

Parameter Value Description Status

KA1 (1/M) ka1/kd1 Affinity constant for A1+B Global

KA2 (1/M) ka2/kd2 Affinity constant for A2+B Global

Example data
BIAevaluation project file Competitive\Zkomp.ble . To fit this data
adequately, the higher molecular weight analyte is assumed to block
two ligand binding sites per analyte molecule.
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C.1.6 Heterogeneous ligand (parallel reactions)
This model describes an interaction between one analyte and two
independent ligands. The binding curve obtained is simply the sum of
the two independent reactions.

Heterogeneous ligand situations frequently arise in practice through
heterogeneous immobilization of ligand (e.g. amine coupling of
proteins, where the ligand has multiple attachment points), as well as
through heterogeneity in the ligand preparation itself. In cases where
the heterogeneous ligand model is found to give the best fit to the
observed sensorgrams, further experimental efforts to reduce the
heterogeneity are recommended where possible.

If you fit experimental data to this model, use View:Components  to
examine the relative contributions of binding to the two ligands to the
fitted curves.

Reaction scheme and reactants

Species Type Comments

A Analyte –

B1 Ligand –

B2 Ligand –

AB1 Complex Formed by binding A to B1

AB2 Complex Formed by binding A to B2

Bulk and drift

Bulk refractive index contribution RI during sample injection.
No drift.
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Parameters
Parameter Description Fitting status Comments

tOn Starting time for
sample injection (s)

Constant

tOff Ending time for
sample injection (s)

Constant

Conc Analyte concentration
(M)

Constant Attached to
keyword

Rmax Maximum analyte
binding capacity (RU)

Fit globally

ka1 Association rate
constant for
A+B1=AB1 (M-1s-1)

Fit globally

kd1 Dissociation rate
constant for
AB1=A+B1 (s-1)

Fit globally

ka2 Association rate
constant for
A+B2=AB2 (M-1s-1)

Fit globally

kd2 Dissociation rate
constant for
AB2=A+B2 (s-1)

Fit globally

RI Bulk refractive index
contribution (RU)

Fit locally Negative
values allowed

Rate equations
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Calculated report parameters
The fitting report also includes values for selected parameters.

Parameter Value Description Status

KA1 (1/M) ka1/kd1 Affinity constant for A+B1 Global

KA2 (1/M) ka2/kd2 Affinity constant for A+B2 Global

Example data
None provided.

C.1.7 Two-state (conformational change)
This model describes a 1:1 binding of analyte to immobilized ligand
followed by a conformational change in the complex. To keep the
model simple, it is assumed that the conformationally changed
complex can only dissociate through the reverse of the conformational
change:

A + B  =  AB  = AB*

Note that conformational changes in ligand or complex do not
normally give a response in BIACORE. A good fit of experimental
data to a multi-state model should be taken as an indication that
conformational properties should be investigated using other
techniques (e.g. spectroscopy or NMR), rather than direct evidence
that a conformational change is taking place.
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Reaction scheme and reactants

Species Type Comments

A Analyte –

B Ligand –

AB Complex Formed by binding A to B

ABx Complex Formed by conformational change from AB

Note that in this model the conformational change only occurs in the
complex AB, not in free ligand B. In addition, the only way ABx can
dissociate to release free A is through prior conversion to the form AB.
This is probably a considerable simplification of real systems involving
conformational change.

Bulk and drift

Bulk refractive index contribution RI during sample injection.
No drift.
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Parameters
Parameter Description Fitting status Comments

tOn Starting time for
sample injection (s)

Constant

tOff Ending time for
sample injection (s)

Constant

Conc Analyte concentration
(M)

Constant Attached to
keyword

Rmax Maximum analyte
binding capacity (RU)

Fit globally

ka1 Association rate
constant for
A+B1=AB1 (M-1s-1)

Fit globally

kd1 Dissociation rate
constant for
AB1=A+B1 (s-1)

Fit globally

ka2 Forward rate constant
for AB=ABx (s-1)

Fit globally

kd2 Backward rate
constant for AB=ABx
(s-1)

Fit globally

RI Bulk refractive index
contribution (RU)

Fit locally Negative
values allowed

Rate equations



_________________________________________________________________ Predefined models

BIAevaluation Software Handbook C-21

Calculated report parameters
The fitting report also includes values for selected parameters.

Parameter Value Description Status

K (1/M) (ka1/kd1)*
(ka2/kd2)

Apparent affinity constant Global

Example data
BIAevaluation project file Two State\Myo.ble .

Models for separate ka/kd fitting describe only the association or
dissociation phase of the sensorgram, and are intended for use in
situations where one of the phases cannot be used for evaluation.
Wherever possible, simultaneous evaluation of ka and kd is preferable,
both for convenience and robustness.

Models for separate ka/kd are defined in terms of an integrated rate
equation rather than a reaction scheme. Systems where the rate
equations cannot be integrated mathematically cannot be modelled
with separate ka/kd. The model definition specifies the independent
variable (x-axis parameter) for the equation, which in kinetic contexts
is always time.

C.2.1 1:1 (Langmuir) association
This model fits the association phase of a 1:1 interaction to the
integrated rate equation:

( )( )( )R R 1 e RIeq
k C k t ta d 0= − +− + −

where

R
k C

k C k
Req

a

a d
max=

+
⋅

The model requires values for kd, which may be obtained by first
evaluating the dissociation phase of the sensorgram. The association
phase can be evaluated without knowledge of kd by using the model
1:1 (Langmuir) association (kobs)  provided as an additional model
(Section C.4.3).

C.2 Models for separate ka/kd
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Parameters
Parameter Description Fitting status Comments

ka Association rate
constant (M-1s-1)

Fit locally

Rmax Maximum analyte
binding capacity (RU)

Fit locally

Conc Analyte concentration
(M)

Constant

t0 Injection start time (s) Constant

kd Dissociation rate
constant (s-1)

Constant

RI Bulk refractive index
contribution (RU)

Fit locally Negative
values allowed
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Calculated report parameters
The fitting report also includes values for selected parameters.

Parameter Value Description Status

KA (1/M) ka/kd Equilibrium binding
(affinity) constant

Global

KD (M) kd/ka Equilibrium dissociation
constant

Global

Req (RU) ka*Conc*Rmax/
(ka*Conc+kd)

Steady state binding level Local

kobs (1/s) ka*Conc+kd Observed rate constant
(slope of ln(dR/dt) against t)

Local

C.2.2 1:1 (Langmuir) dissociation
This model fits the dissociation phase of a 1:1 interaction to the
integrated rate equation:

( )R R e Offset0
k t td 0= +− −

The Offset  term allows the dissociation phase to approach a non-zero
baseline (compare the use of the second bulk refractive index
contribution in models for simultaneous ka/kd, Section B.1.3).
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Parameters
Parameter Description Fitting status Comments

kd Dissociation rate
constant (s-1)

Fit locally

R0 Response at start of
fitted data (RU)

Constant

t0 Time at start of fitted
data (s)

Constant

Offset Response at infinite
time (RU)

Fit locally

Models for general fitting are intended for fitting non-kinetic data.
Applications of such fitting procedures in BIAevaluation include
calculation of calibration curves using a 4-parameter equation (Section
5.2), calculation of affinity in solution from measurements of free
interactant concentrations (Section 6.3) and calculation of surface
interaction affinity from a plot of Req against C (Section 6.2).

Models for general fitting are defined in terms of an expression
describing the ordinate (y-axis) value as a function of an independent
variable (x-axis).

C.3.1 4-parameter equation
The 4-parameter equation is a general curve fitting model which is
suitable for generating calibration curves for concentration
determination (Section 5.2). The model fits a plot of the response
against concentration to the equation:

response R
R R

1
Conc

A

hi
hi lo

1

A 2
= −

−

+








C.3 Models for general fitting
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Parameters
Parameter Description Fitting status Comments

Rhi Response at
infinite
concentration

Fit locally

Rlo Response at zero
concentration

Fit locally

Conc Analyte
concentration (M)

Constant Independent
variable

A1 Fitting constant Fit locally

A2 Fitting constant Fit locally

The fitting constants A1 and A2 are mathematical parameters that do
not have any direct physical interpretation.



Predefined models _________________________________________________________________

C-26 BIAevaluation Software Handbook

C.3.2 Linear fit
This model fits data to a straight line:

y=kx+m
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C.3.3 Solution affinity
This model derives the affinity constant in solution from
measurements of the free concentration of one interactant in steady
state mixtures with the other. In the steady state mixtures, the total
concentration of component A is varied while that of B is kept
constant. To use the model, prepare a plot of the free concentration of
B against the total concentration of A and fit the curve to the model.
The total concentration of B is entered as a constant in the fitting
wizard. The affinity constant for the interaction of A and B is
displayed in the report (see  (Section 6.3).

C.3.4 Steady state affinity
This model calculates the affinity constant for the surface interaction
from a plot of steady state binding level Req against analyte
concentration (Section 6.2).
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The steric interference factor n may be used to compensate for steric
blocking of additional binding sites by a single analyte molecule. Note
that this is not the same as multivalent analyte binding to more than
one site, which gives an avidity effect.
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The models described below may be imported into BIAevaluation from
the file More Models.mdl .

C.4.1 1:1 binding with exponential baseline drift
This model for simultaneous ka/kd evaluation describes 1:1 binding
superimposed on an exponential decrease in baseline starting at a
given time. By setting the start of the baseline drift to the start of the
sensorgram (the default initial value), the model approximates a
capturing situation with slight dissociation of the capturing molecule
from the surface.

This model is not a completely correct description of a capturing
situation with dissociation, since the baseline drift does not account
for the loss in analyte binding capacity resulting from dissociation of
the capturing molecule with attached ligand. Moreover, the loss in
response is an approximation which does not take into account the
difference in effect between dissociation of a capturing molecule with
and without attached ligand. However, definition of an accurate
model for the capturing situation is difficult, and the increased number
of parameters required potentially reduces the stability of the fitting
(see Section A.4). A situation where capturing molecule dissociates to
a significant extent is not suitable for kinetic studies, and the model
with exponential baseline drift is a fair approximation provided that
the drift is small.

The baseline should not be set to zero when this model is used to fit
to sensorgrams.

If you fit experimental data to this model, use View:Components  to
examine the relative contributions of analyte binding and baseline drift
to the fitted curves.

The model is identical to that for 1:1 (Langmuir) interaction except for
the addition of an exponential expression for drift:

C.4 Additional models
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Drift R e0
k_bg(t tOn)= − −

where R0 is the response at the start of drift
k_bg is the rate constant for the drift in RU.s-1

The drift may be positive or negative (k_bg is allowed to have a
negative value). For evaluation of  capturing situations with
background dissociation, the value obtained for k_bg should always be
positive (so that the drift is negative).

C.4.2 1:1 binding with mass transfer km(m/s)
This model for simultaneous ka/kd evaluation represents an alternative
approach to modelling mass transfer limitations (compare Section
C.1.3), using explicit mathematical expressions for the forward and
backward rate equations instead of checking the Mass transfer  box for
the analyte.
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The forward and backward rate constants are given by

k
k

1
k B

10 mw k

forward
a

a
9

m

=
+

⋅ ⋅

   entered as ka/(1+ka*B/(1e9*mw*km))

and

k
k

1
k B

10 mw k

backward
d

a
9

m

=
+

⋅ ⋅

  entered as  kd/(1+ka*B/(1e9*mw*km))

where ka, kd are the rate constants for the interaction
mw is the molecular weight of the analyte
km is the mass transport coefficient
109 is a conversion factor between molar concentrations and RU

This approach thus modifies the effective forward and backward rate
constants directly with an expression that is related to both the rate of
mass transfer and the concentration of available binding sites (i.e. the
potential rate of interaction). At high mass transfer rates, the
denominator in the expressions for kforward and kbackward approaches 1
and the constants approach the interaction rate constants.

The units of km used in this model are m.s-1, and the model includes
analyte molecular weight as a parameter. When mass transfer is
modelled using the Mass transfer  box for analyte (Section C.1.3), the
constant kt is expressed in s-1 and the molecular weight is included in
the magnitude of kt. These two ways of expressing the mass transfer
constant are related by the expression:

k mw kt m≈ ⋅ ⋅109

Fitting mass transport-limited data to the two kinds of model gives
equivalent results.
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C.4.3 1:1 Langmuir association (kobs)
This model for separate ka/kd evaluation calculates the observed rate
constant (kobs=kaC+kd) and the steady state binding level Req. The
association rate constant ka may be obtained from a secondary plot of
kobs against C without knowledge of the dissociation rate constant kd.

Parameters
Parameter Description Fitting status Comments

kobs Observed rate
constant (s-1)

Fit locally

Req Steady state binding
level (RU)

Fit locally

Conc Analyte concentration
(M)

Constant

t0 Injection start time (s) Constant

RI Bulk refractive index
contribution (RU)

Fit locally Negative
values allowed
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Notes: The analyte concentration Conc  is not used in fitting data to
the model. It is however included as a parameter so that a
secondary plot of kobs against C can be constructed from the
fitting data.

To obtain a correct estimate of the steady state response Req,
the starting time for the association t0 must be set to the
actual time of injection. By default, t0 is the starting time for
the selected data. You may therefore need to adjust the
suggested values for t0 before performing the fit. This is
particularly important if you intend to plot Req against C to
estimate the affinity constant.

C.4.4 Average
This is a general fitting model designed to calculate the average value
over a selected portion of a curve. It is useful for calculating steady
state levels from sensorgrams where steady state has been reached.

The formula used for the fitting equation is simply a single parameter
representing the average:

The initial value for this parameter is set to YAverage , which is the
average ordinate (y-axis) value over the range of the selected data.



Predefined models _________________________________________________________________

C-34 BIAevaluation Software Handbook

When steady-state binding data is fitted using this model, the fitting
window displays the average value as a horizontal line over the range
of selected data (this line is in fact the calculated “fitted curve”). The
Parameters  tab in the fit window displays values for Req and Conc , so
that a plot of Req against C can be constructed directly using Fit:Plot
Parameters  (see Section 4.6).
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from rate constants, 6-1
from solution binding data, 6-3
from steady state binding level, 6-2

affinity evaluation, 6-1
aligning curves, 3-14, 7-30
analyte, B-10
arithmetical functions, 3-22
arranging windows, 7-14
assessing kinetic fit, 4-11
auto-scale, 3-8
average model, C-33
avidity effects, C-9

baseline adjustment, 3-13, 4-3, 7-29
baseline drift, B-3
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binding rates, 5-1
bivalent analyte model, C-9
bulk and drift, B-14
bulk refractive index contribution, 4-20, B-5
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Calculate  menu
Derivatize , 7-31
Normalize , 7-32
plot window, 7-28
X-Transform , 3-15, 7-30
Y-Transform , 3-13, 7-28

calculating unknowns, 5-4
from calibration window, 5-8

calibration curve
fitting algorithms, 5-3, 7-49

calibration curve display, 5-4
calibration curve names, 5-7
calibration data, 5-6
calibration window, 1-6

calculating unknowns, 5-8
Data menu, 7-57
Edit  menu, 7-55
File  menu, 7-53
Help  menu, 7-58
toolbar, 7-53
View  menu, 7-55
Window  menu, 7-58

changing parameter properties, B-3
checking a model definition, B-15
chi2 (χ2), 4-8, 4-14, A-6
clearing data in a sheet, 7-46
clearing data selection, 7-23
clipboard

BIAevaluation, 7-10, 7-20
Windows, 7-20

closing BIAevaluation, 7-10
comparing calibrations, 5-7
comparing curve shapes, 3-17
complex models, 1-2
components in complex interactions, 7-39
concentration evaluation, 1-2
concentration measurement

binding levels, 5-1
binding rates, 5-1
calculating unknowns, 5-4, 5-7
comparing calibrations, 5-7
replicate values, 5-4
unknown points, 5-2

constants in kinetic evaluation, 4-6
copying curves to other applications, 7-20
copying numerical data from fit window, 7-38
copying sheet data, 7-45
correlated parameters, A-7
correlation coefficient, A-6
creating curves from sheet data, 3-26, 7-49
creating models, B-10
creating secondary plots, 4-21
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cubic spline fitting, 7-50
curve alignment, 7-30
curve colour, 3-7
curve fitting

algorithm, A-1
local minimum, A-3

curve history, 7-12
curve list, 3-7
curve marker, 3-7
curve properties, 7-2, 7-11
curves

aligning, 3-14
colour, 7-11
copying to other applications, 7-20
creating from sheet data, 3-26, 7-49
curve name, 7-11
cutting data, 3-11
deleting, 7-10
functions in split view, 7-27
generated x-values, 3-5
in current working set, 3-7
line type, 7-11
markers, 7-11
overlay plot, 3-7
properties, 3-7
selecting data, 3-11
single curve plot, 3-7
title, 3-9
working set, 7-22

custom filter, 3-25, 7-47
cutting curves, 7-10, 7-20
cutting data, 3-11
cutting sheet data, 7-45
CVx, 5-5
CVy, 5-5

data for concentration evaluation, 5-1
Data menu

Calculate Unknowns , 7-57
Calculate Values , 7-51
calibration window, 7-57
Compare Calibrations , 7-58
Create Curve , 3-27, 7-49
Filter , 3-24, 7-47
Generate Calibration , 5-3, 7-49
sheet window, 7-47
Sort , 3-23, 7-47

data presentation, 3-6
data transformation, 3-11

adding new curves, 3-14
aligning curves, 3-14



Index____________________________________________________________________________

iv BIAevaluation Software Handbook

normalizing, 3-16
replacing original curves, 3-14

decimal separator, 2-2
deleting selected data, 7-21
deleting curves from project window, 7-10
derivative plot, 7-27, 7-31
difference plot, 7-30
differences from version 2.x, 1-1
dilution errors, 4-24
display

arranging windows, 7-14
calibration curve, 5-4
curve properties, 3-7
fitted curves, 4-9
gridlines, 3-8
legend, 3-10
number of digits, 7-14
relative residuals, 7-14
scale, 3-8, 7-24
zoom, 3-8

Edit  menu
calibration window, 7-55
Clear , 7-46
Clear Selection , 7-23
Copy , 7-10, 7-38
Copy Graph , 7-20
Curve Properties , 3-7, 7-11
Cut , 3-12, 7-10, 7-20
Delete , 7-46
fit window, 7-38
Insert Paste , 7-45
Paste , 7-10, 7-21
Paste Curve , 3-12
plot window, 7-20
project window, 7-10
Redo , 7-20
Remove , 7-10
Remove Selected Data , 7-21
Select , 3-11, 7-23
Select All , 7-55
sheet window, 7-45
Undo , 7-20
Undo Cut , 3-12
Working Set , 7-22

editing models, 7-33, B-2
evaluating concentration data, 5-1
evaluation as an experimental tool, 4-25
evidence for conformational change, C-18
examining sensorgram components, 4-20



____________________________________________________________________________Index

BIAevaluation Software Handbook v

example data files, C-1
decimal separator, 2-2

experimental considerations, 4-23
exponential format, 7-4
exporting calibration data, 7-54
exporting curves, 7-7, 7-18
exporting models, 7-9

failure to fit curves, 4-24, A-4
file format

exported curves, 7-7
exported models, 7-8
projects, 7-7

File  menu
calibration window, 7-53
Exit , 7-10
Export , 7-7
Export Models , 7-9
fit window, 7-36
Import Models , 7-8
New Project , 7-5
New Sheet , 7-5
Open , 3-1, 7-5
plot window, 7-18
Print , 7-18, 7-36, 7-44, 7-54
project window, 7-5
Save, 7-6
Save As , 7-6
sheet window, 7-43

file types, 3-1, 7-6
filtering data, 3-24, 7-47
finding the best fit, 4-25
Fit  menu

Edit Models , 7-13, 7-33
fit window, 7-41
General , 7-33
Kinetics Separate ka/kd , 7-33
Kinetics Simultaneous ka/kd , 4-2, 7-33
Plot Parameters , 4-21, 7-41
plot window, 7-33
Preferences , 7-13, 7-33
project window, 7-12
Simulate Curve(s) , 7-12, 7-33

fit window, 1-4
curve display, 4-9
Edit  menu, 7-38
File  menu, 7-36
Help  menu, 7-42
parameters, 4-10
removing a fit, 4-15
report, 4-10
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residual plots, 4-9
selections, 4-11
toolbar, 7-35
View  menu, 7-38
Window  menu, 7-42

fitted curves, 4-9
fitting functions for calibration curves, 7-49
fitting parameters, 4-10
fitting preferences, 7-13
fitting progress, 4-7
fitting report, 4-10
fitting simultaneous ka/kd, 4-2
fitting statistics, 4-14, 7-13
fitting status, 4-7, B-3
format number, 7-56

general curve fitting, 4-19
generated x-values, 3-5
generating calibration curve, 5-3, 7-49
global fitting, 1-1
global parameters, 4-6
gridlines, 3-8, 7-24

header row, 3-24
Help  menu

calibration window, 7-58
fit window, 7-42
plot window, 7-34
project window, 7-16
sheet window, 7-52

heterogeneous analyte (competing reactions) model, C-12
heterogeneous ligand (parallel reactions) model, C-16

identifying mass transfer limitations, 4-16
immobilization chemistry, 4-24
importing models, 7-8
initial values for curve fitting, 4-7, 4-24, A-2
injection start

effect of incorrect selection, 4-12
injection start and stop, 4-4
installation, 2-1

with BIACORE X Control Software, 2-2
interpreting residual plots, 4-10
invalid data points, 7-22
iteration speed, 4-8
iterations, 4-8
iterative fitting, A-2
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keywords, 4-6, 5-2
kinetic constants from mass transfer limited data, 4-16
kinetic evaluation, 4-1

assessing the fit, 4-11
constants, 4-6
examining the fit, 4-9
fitting mass transfer limited data, 4-16
fitting progress, 4-7
fitting separate ka/kd, 4-17
fitting statistics, 4-14
fitting status, 4-7
initial values, 4-7
parameter values, 4-10
refitting data, 4-14
report, 4-10
selecting data, 4-4
selecting the model, 4-6

labels, 3-9, 7-25
legend, 3-9, 7-25
ligand, B-10
linear fit, C-26
linear fitting for calibration curve, 7-50
local parameters, 4-6
logarithmic derivative plot, 7-28, 7-31
logarithmic plot, 7-29
logarithmic quotient plot, 7-28, 7-29
long file names, 1-2

making data points invalid, 7-22
Marquardt-Levenberg algorithm, A-1
mass transfer, B-6
mass transfer coefficient, B-7, C-9
mass transfer limited data, 4-15
measuring solution affinity, 6-4
model complexity, A-4
model definition

1:1 binding with drifting baseline, C-4
1:1 binding with mass transfer, C-7
1:1 (Langmuir) association, C-21
1:1 (Langmuir) binding, C-2
1:1 (Langmuir) dissociation, C-23
1:1 binding with exponential baseline drift, C-29
1:1 binding with mass transfer, km(m/s), C-30
1:1 Langmuir association (kobs), C-32
4-parameter eqaution, C-24
average, C-33
bivalent analyte, C-9
bulk and drift, B-14
checking the model, B-15
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conventions, B-10
for separate ka/kd, B-16
general models, B-17
heterogeneous analyte (competing reactions), C-12
heterogeneous ligand (parallel reactions), C-16
linear fit, C-26
negative parameter values, B-14
rate equations, B-14
reactant names, B-12
reactants, B-11
reaction scheme, B-13
solution affinity, C-27
steady state affinity, C-27
two-state (conformational change), C-18

model editor, 1-2, 7-13, 7-33, B-2
models

exporting, 7-9
importing, 7-8

molecular weight
in model definitions, B-10

mouse functions, 7-2

negative values, B-14
non-specific binding, 4-24
normalizing curves, 3-16, 7-32
normalizing to specified values, 3-16
number format, 7-14, 7-56
number of blocked sites, B-7
number of displayed digits, 7-14
number of fitted parameters, A-4
numerical input

exponential format, 7-4
shorthand format, 7-4

numerical integration, 1-2, A-2

observed rate constant, C-32
offset, C-23
opening a new project, 7-5
opening a new sheet, 7-5
opening files, 3-1, 7-5
opening result files, 3-3
opening saved projects, 3-2
opening text files

as curves, 3-4
as sheet, 3-4

overlay plot, 3-6
from sequential injections, 3-18
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page header and footer, 7-19
parameter properties, B-13
pasting curves into plot window, 7-21
pasting curves into project window, 7-10
pasting formulas in sheets, 7-45
pasting sheet data, 7-45
plot window, 1-4

Calculate  menu, 7-28
Edit  menu, 7-20
File  menu, 7-18
Fit  menu, 7-33
Help  menu, 7-34
toolbar, 7-17
View  menu, 7-24
Window  menu, 7-34

plotting sheet data as a curve, 7-49
point-to-point fitting, 7-50
precision, 5-5
predefined modesl, C-1
presenting data, 3-6
printing

calibration window contents, 7-54
curve history, 7-12
fit window contents, 7-36
page header and footer, 7-19
plot window contents, 7-18
setup, 7-19
sheet window contents, 7-44

project
opening, 7-5

project files, 3-2
project window, 1-3

Edit  menu, 7-10
File  menu, 7-5
Help  menu, 7-16
selecting curves, 3-6
toolbar, 7-5
View  menu, 7-12
Window  menu, 7-14

project window Fit menu, 7-12
projects

file format, 7-7
saving, 7-6

Qubic spline, 7-50

rate equations, A-2, B-14
reactants, B-11
reaction scheme, B-13
reagent purity, 4-24
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recent file list, 7-9
reciprocal plot, 7-29
recovering deleted data, 3-12
redo edit, 7-20
reference line, 7-26

moving, 7-2
refitting data, 4-14
regeneration performance, 3-26
relative residuals, 4-9, 7-14
removing a fit, 4-15
removing data, 3-11, 4-3

from single curves, 3-12
removing filters, 3-25
replace original, 3-14
replicates in concentration measurement, 5-4, 7-50
report parameters, B-8
report point table

as rpt file, 3-5
in result files, 3-3
keywords, 5-2
opening as sheet, 3-22

report tab in fit window, 4-10
residual plots, 4-9
residuals

in local and global fitting, 4-12
normal levels, 4-9
relative residuals, 7-14

result files, 3-3
right mouse button, 1-3, 7-2
row numbers in filtered sheets, 7-48

sample dispersion, 4-24
saved projects, 3-2
saving projects, 7-6
scale, 3-8

adjust scale, 7-24
display, 7-24

scaling curves
x-direction, 7-31
y-direction, 7-29

secondary plots, 4-21
selecting

curves, 3-6, 7-2
data in sheet window, 7-3

selecting data, 3-11
selecting data for kinetic evaluation, 4-4

how to choose the data, 4-5
on individual curves, 4-4

selecting the model for kinetic evaluation, 4-6
selections in fit window, 4-11
sensorgram components, 4-20, 7-39
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separate association and dissociation phases, 4-17
sequential injections, 3-18
setting curve properties, 7-2
sheet window, 1-5

arithmethical functions, 3-22
calculating values, 5-9
Data menu, 7-47
Edit  menu, 7-45
File  menu, 7-43
header row, 3-24
Help  menu, 7-52
row-oriented functions, 3-23
toolbar, 7-43
Window  menu, 7-52

shifting curves
x-direction, 7-30
y-direction, 7-29

shorthand for numerical input, 7-4
simulate curves, 7-33
simulating kinetic data, 4-22
simultaneous fitting, 1-1
single curve plot, 3-7
smoothing factor, 7-27, 7-31

in spline fitting, 7-50
software wizards. see wizards
solution affinity, 6-3

procedure for determining, 6-4
solution affinity model, C-27
sorting data, 3-23, 7-47
spline fitting, 7-50
split view, 4-5, 7-27

curve functions, 7-27
spreadsheet functions, 3-22
standard deviation, A-8
standard error, 4-14, 7-13, A-6
standard points for calibration curve, 5-2
starting BIAevaluation, 7-1
statistical fitting parameters, A-6
statistics for fitting, 4-14
steady state affinity model, C-27
steady state binding level, 6-2
subtracting a blank run, 7-30
subtracting bulk refractive index, 4-20
sum of squared residuals, A-1
system requirements, 2-1

text file format, 3-4
text files

decimal separator, 2-2
default curves, 3-5
export format, 7-7
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tool tips, 1-2
T-value, 4-14, 7-13, A-7
two-state (conformational change) model, C-18

undo edit, 7-20
unknown points for concentration measurement, 5-2
unknowns, 5-6, 5-7
unzoom, 7-24
updating models, 2-2

variable analyte concentration, B-10
View  menu

Adjust Scale , 3-8, 7-24
calibration window, 7-55
Components , 4-20, 7-39
Curve History , 7-12
fit window, 7-38
Format Number , 7-56
Gridlines , 7-24
Labels , 3-9, 7-25
Legend , 3-10, 7-25
Overlay , 7-12
plot window, 7-24
project window, 7-12
Reference Line , 7-26
Scale , 3-8, 7-24
Split View , 7-27
Unzoom , 3-8, 7-24

Window  menu
calibration window, 7-58
fit window, 7-42
plot window, 7-34
project window, 7-14
sheet window, 7-52

Windows clipboard, 7-20
wizards, 1-3

calculating values, 5-9
curve alignment, 3-15
installation, 2-1
kinetic evaluation, 4-2
kinetic simulation, 4-22
simultaneous ka/kd fitting, 4-2
separate ka/kd fitting, 4-18

working set, 7-22
workspace, 1-3
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x-transformation, 7-30
x-values

generated, 3-5

y-transformation, 7-28

zooming the display, 3-8
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